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General Procedure for Configuring the TSI1000 Tally Display Controller 

 

1 Introduction 
 
The following document outlines a general procedure on configuring a TSI1000 Tally System 
Interface controller (TSI). This document is not intended to explain in detail the operation of the Tally 
System Console program, so please refer to the online help for information specific to the TSI1000. In 
the case of any inadvertent contradictions between this document and the online help, the online help 
will be considered correct. 
 
The TSI1000 Tally Display System (TDS) is highly configurable, and capable of an almost infinite 
variety of tally operations. This document concerns itself with the most commonly -used applications. 
If you have an application in mind which is not covered in this document, please feel free to consult 
Image Video for further information. 
 

2 General Configuration Procedure 
 

2.1 General Installation 
 
1. To communicate with the TSI1000 for configuration purposes you will need an IBM PC-

compatible computer (henceforth called the "configuration PC"), equipped with an RS232 serial 
port, and running Win95, Win 98 or some later version of Microsoft Windows. You will also need 
an RS232 null-modem cable (handshake lines not required). 

 
2. Install the Tally System Console Program on the PC which will be used to configure your tally 

system. Depending on how you receive your software, this will consist of simply running a 
SETUP.EXE program or other provided executable program. 

 
3. Connect the null-modem cable from COM1 of the TSI1000 to the serial port of the configuration 

PC. 
 
4. Run the Tally System Console program. 
 
5. In the Tally System Console program, click on Resources > System Resources > Port and select 

the PC serial port you have connected to the TSI1000 (usually COM1 or Com2). Close the dialog 
box. 

 
6. Click on the "File" menu item and confirm that "Work offline" is unchecked. 
 
7. Check the front panel of the TSI1000 to confirm that the "Console" LED is on.  
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2.2 System Configuration 
 
This is a general outline of the steps you will take to configure your tally system. Further instruction 
on how to carry out each step are given in detail later on in this document. 
 
1. Press F1 to enter the online help. Click on Tally System Design > Supported Resource Devices to 

read about the router/switching devices of interest to your system. This will tell you important 
information on which ports may be used, the names or numbering scheme used for that particular 
router, serial baud rates, and so on. When selecting the port, keep in mind whether it is RS-422, 
RS-232, or on a network, and also note that COM1 and COM7 are reserved for the TSC and 4211s 
respectively. 

 
2. Create the routers and switching devices (called "resource devices") which you will be connecting 

to the TSI1000. For further information on configuring the router/switching devices, read section 
"Defining Resource Devices". Generally, you will enter a name for the device, "add" it, then select 
the port it is connected to (COM8, COM9 etc.), it's interface number (usually "2") and the type of 
device (GVG 7000 router, etc.). 

 
3. If you have displays in your system which will follow and display the names of sources selected 

by your tallied routing and switching systems, and you wish to display names other than by their 
physical input numbers or mnemonics, then you will want to enter your own name for each source 
in your system. For further information, see the section on "Defining Source Names". Note that the 
TSI1000 receives names automatically from a few of the supporting switcher or routing devices, 
but in many cases you will need to enter your own source names. 

 
4. If you have sources in your system which feed more than one routing or switching device (for 

example a camera which is directly connected to a certain router input and als o to a certain 
switcher input), see the section on "Defining Common sources". 

 
5. If you have fixed connections in your system which route signals from a resource output to one or 

more resource inputs, (for example a router destination which feeds a switcher input), then read 
and follow the section on "Adding Resource Interconnections".  

 
6. If you have any sort of text display device in your system, such as the Image Video 1500 series 

UMDs, then read and follow the section on "Programming Displays". 
 
7. If you want to control GPI outputs which become active when  certain conditions are met, (e.g. 

camera or CCU tallies) then read and follow the section on "Programming GPI outputs". 
 
8. In a typical installation where on-air tally from a production switcher is required, it is necessary to 

designate an on-air switcher output, (i.e. the “program” bus), and possibly a preset bus, by using 
the “On-air” and “Next -to-air” resource interconnections. This is covered in the section on 
“Program and Preset Output Designation”. 
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3 System Overview  

3.1 Tally System Interface Controller  
 
The Tally System Interface controller, known as the TSI1000, or simply the TSI, consists of a two 
rack-unit controller frame with 10 RS422 ports, two RS232 ports, an Ethernet port, and a  Sony SBUS 
port.  
 

Port name  Type  Connector Note 
COM1 RS-232 DB-9 Male Reserved for 

Tally System 
Console 

COM2 RS-232 DB-9 Male  
COM3-COM6 RS-422/485 RJ-11 jack  
COM7 RS-422/485 DB-9 Female  Reserved for 

Image Video 
4211 GPI unit. 

COM8-COM12 RS-422/485 DB-9 Female   
CTL-1 Sony SBUS Coax Use of SBUS 

disables 
COM12. 

CTL-2 IV Coax Coax  
Ethernet Ethernet RJ-45  

 
 
The configuration of the Tally System controller is edited using the Tally System Console program. 
The configuration is edited using various dialog boxes and display edit fields. Changes are sent to the 
TSI “on the fly” and take effect immediately whenever a particular dialog box is closed or as 
characters are typed into display edit fields. The configuration may be saved to the PC disk, and 
changes are also immediately saved to a flash disk in the TSI1000. Note that configurations cannot be 
downloaded back off the TSI1000, so it is important to keep track of the configuration file which has 
been loaded in order to make future changes to the configuration. 
 

3.2 Resource Devices 
 
Resource devices represent the routing devices to which the TSI1000 interfaces in the real world. The 
details of a resource device are defined in the Configure Resource Devices dialog box. Each device 
will require the entry of information such as the type of device (Grass Valley 7000 router, Philips 
DD35 switcher, etc.), the identification number of the TSI1000 to which the device is connected 
(called the "interface number"), the TSI1000 serial port on which the device will communicate, and so 
on. 
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3.2.1 Resource Outputs 
 
Each resource device encompasses a collection of  resource outputs which represent real-world router 
or switcher destinations. Each resource output may select one or more resource inputs. The list of 
inputs selected by a given output is  referred to as the output status. The output status for most resource 
outputs are taken from information provided by a hardware device via a serial port or Ethernet 
connection and may be displayed as text information on an under-monitor display, used to drive output 
tallies, and so forth. 
 
It is also possible to create resource devices which do not represent devices in the real world, and 
which are used for carrying out internal tally functions. These resource devices are specified in the 
Configure Resource Devices dialog box as “Virtual”. Resource outputs associated with virtual 
resource devices do not take their status directly from real-world devices, but rather from a set of 
instructions entered into an edit box by the operator, known as a "control stri ng", which defines their 
operation. The resource output control string can reference such external devices as signal routers and 
switchers, and external General Purpose Interface inputs (also known as GPI or parallel inputs). In it’s 
simplest application, a virtual resource output will appear to select an input whose name is typed into a 
virtual output control edit box. Typing a number of input names separated by commas into a virtual 
output control edit box will make the resource output appear to select multiple inputs, rather like a 
mixer. 
 

3.2.2 Resource Inputs 
 
External devices report selected inputs in the form of a predefined name or number, known as the 
“native name”. Native names can be directly displayed by the TSI1000, or they can be associated and 
substituted with a more meaningful name, called a "name override", to be displayed instead. For 
example a switcher may refer to it’s inputs as a set of numbers from 1 to 64, each of which can be 
given an arbitrary name override, such as “CAM1”, “VTR2”, “Traffic  CAM”, etc. The TSI1000 can 
be programmed to display either the input number, or the name override. Some resource devices use 
names instead of numbers, usually in the form of a category and number (CAM1, CAM2, etc.) and 
these too can be overridden with meaningful display names. 
 
There are two classes of name overrides, "long names" and "short names". The long names are usually 
chosen to be descriptive and obvious in their meaning, for use in single-source displays where there 
are lots of characters available. The short names are usually more mnemonic in nature and are 
normally used in multiple -source displays, such as program bus or mix-effects displays, where 
character space is at a premium. 
 
Each resource input can also be associated with a priority, which is used to determine the order of 
display of inputs in tally displays. The priority of each resource input can be set in the Configure 
Resources dialog box. Zero is the default value of all resource inputs and is the highest priority. The 
lowest priority is 255. 
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3.3 Resource Interconnections 
 
Real-world routing and switching devices are often interconnected so that there are several layers of 
switching which determine the final destination of a given source. An common example is where a 
production switcher has one or more inputs fed by a router output, allowing switcher buttons to be 
assigned to various sources. 
 
Such device interconnections are represented by specifying resource interconnections in the TSI1000 
configuration. Each interconnection is created in the “Resource Interconnections” dialog box, by 
supplying an arbitrary name for the interconnection, along with a interconnection origin (a resource 
device output) and one or more interconnection ends (a resource device input). 

3.3.1 Resource Interconnection Input and Output Entry Format 
 
The resource device output which constitutes the signal origin of a resource interconnection is 
specified in particular way.  
 
Suppose, for example, that we have created a resource device called “RTR1” which has an output 
called “FEED1”,  and further suppose that output “FEED1” is connected to the fifth physical input of a 
switcher called “SW1”. The switcher input is called “5”.  
 
“FEED1” would be considered the signal origin, and it would be entered in the “Origin” field of the 
Resource Interconnection dialog box as “RTR1::FEED1”. Note that the name of the resource device 
and the name of the resource output are separated by two colons. It is a common error to supply only a 
single colon, in which case the resource interconnection would not be successfully created. 
 
Input “5” on switcher “SW1” would be considered the signal “end”, and it would be entered in the 
“Ends” field of the Resource Interconnection dialog box as “SW1::5”, using the same double colon 
format described for the signal origin. Note that a resource interconnection may have no end, or any 
number of ends, allowing a “star” configuration where one signal origin feeds several ends. 
 
There is also an suffix which may be appended to a resource input or output name which specifies a 
routing level (video, left audio, right audio, SDI level, etc.). This suffix, referred to as a "level 
specifier" takes the form of a name or number surrounded by square brackets (e.g. RTR1::001[1] 
where the [1] denotes the first routing level).  Whether the level specifier is required and it's format 
(name, number etc.) is dependent on the type of routing device the resource device represents. Usually 
the level is a number starting from one, but this is dependent on the type of routing device, and 
specific information on this is available in the online help. 
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3.3.2 Program and Preset Output Designation 
 
There is also a special form of a resource interconnection which is used to point to resource outputs in 
the system which are considered to be “On-air” outputs or “Next -to-air” outputs of the system. These 
are also referred to as “Program” outputs and “Preset” outputs respectively. Any source which is 
routed or switched to an “On -air” output is considered to be on-air, and may be tallied as such by the 
system. Any source which is routed or switched to a “Next -to-air” output is considered to be next -to-
air, and may be tallied as such by the system.  
 
A program or preset output may be designated in the configuration by creating a resource 
interconnection which has that resource output as it’s origin, then clicking the “On-air” radio button. 
No interconnection ends need be defined. A similar procedure is followed to designate a preset output. 

3.4 Tally Displays 
 
Tally displays are output devices which present info rmation to the people operating a studio system. 
Typically these will be Image Video under-monitor displays (UMDs). Other types of displays which 
may be driven by the Image Video tally system are Kaleido multi-viewer displays, or Ensemble video 
insertion devices (used to insert tally information directly into a video monitor), among others. 
 
The TSI1000, in combination with the Image Video 4211 General Purpose Interface unit, supports the 
control of general-purpose outputs (relay contacts or voltage outputs ). These could be properly classed 
as display devices, but are treated in a separate section of this document.  
 
Displays can be configured for connection to any serial port in the controller, except for COM7 which 
is reserved for GPI use. Image Video under-monitor displays are usually configured to run on one or 
more of COM3, COM4, COM5 or COM6, because of the convenient RJ-11 connection. 
 
In the simplest possible application, tally displays are programmed by simply entering the text to be 
displayed into a  display configuration dialog box. If the Tally System Console Program is connected 
and in communication with a TSI1000 which is driving a tally display, text typed into the display 
configuration dialog box will appear immediately on the display, character-by-character. However, to 
allow more complex display functions to be programmed, a programming language is recognized by 
the TSI for the information entered in certain edit fields and dialog boxes within the Tally System 
Console program. This programming language is introduced in a separate section below. 

3.5  General-Purpose I/O 
 
General-purpose I/O ports are parallel ports used for providing contact closures or control voltages to 
the TSI1000, and for providing contact closures or control voltages out of the TSI1000. The parallel 
port hardware is contained in a separate optional unit, the Image Video Model 4211 General Purpose 
Interface unit. The 4211 is serially connected to the TSI1000 COM7 port. Each 4211 has up five 
parallel I/O connectors, each of which can be loaded with eight inputs, eight outputs, or both. As 
typically ordered, a 4211 will have 40 inputs and 40 outputs available in groups of 8 on five 37-pin 
‘D’ connectors. The TSI supports a total of 512 inputs and outputs. More than one 4211 can be 
connected to the same port using a multi-drop serial connection. 
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Each 4211 unit has a DIP switch on the rear panel which is used to assign the inputs and outputs to a 
certain block of addresses within the TSI configuration. The address of each box is entered on the DIP 
switch as a binary address, starting from 0. Each box takes up a number of addresses equal to the 
number of I/O connectors on the rear panel. Therefore if there are three 40 I/O 4211 units in the 
system, each with five rear panel connectors, the first box will have a DIP switch setting of zero 
(binary 00000000) , and it's inputs and outputs will appear in the address range 0-39. The second box 
will have a DIP switch setting of 5 (binary 00000101), and it's inputs and outputs will appear in the 
address range 40-79. The third box will have a DIP switch setting of 10 (binary 00001010) and it's 
inputs and outputs will appear in the address range 80-119. 
 
Inputs to the 4211 are read by the TSI1000 through the serial connection. The TSI1000 uses the 
active/non-active status of the 4211 inputs in various ways to affect tally displays or 4211 outputs. 
4211 inputs are typically used to get tally from production or master control switchers which provide 
parallel tally.  
 
4211 outputs are typically used to drive tallies for cameras, monitors, or CCUs, or for other purposes 
such on-air lights or for controlling parallel-controlled routing devices. 
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4 Tally System Programming Language 
 
In the preceding sections we touched upon tally displays, virtual resource outputs and General Purpose 
outputs. All of these items can be programmed by entering text into an associated edit field in the 
Tally System Console program. 
 
For example, the contents of a tally display can be programmed by typing text into an edit field in the 
Configure Display Units dialog box. A general purpose output can be controlled by typing a “1” or a 
“0” into the “control” edit field in the Configure GPIs dialog box. A virtual resource output can appear 
to select an input of a certain name by typing the name of the input into a resource output control edit 
field. 
 
Within the text programmed to control these various devices, certain predefined character sequences, 
called "embedded functions", can be included to represent certain special information which must be 
displayed in the place of the embedded function. These embedded functions have a common format, 
consisting of a name followed by an opening parenthesis, followed by certain text information of 
interest to the function, following by a closing parenthesis. 
 
For example, typing “add(1,1)” into a display edit field will cause the display to show the number “2”. 
The “add( )” function can be combined with normal text to allow something like “One plus one is 
add(1,1)” to be typed, resulting in the display “One plus one is 2”.  
 
Note that the quotes given in the example will not actually be typed when entering the control strings. 
In fact pairs of quotes within control string cause enclosed information to be displayed verbatim.  
 
Also note that commas o r spaces used within functions act as parameter separators, so if it is necessary 
to use a comma or a space with a parameter, then the parameter must be enclosed within a pair of 
quotes. It is preferable to use commas to separate parameters rather than spaces. 
 
A list of the available functions is available in the online help in the tally system console program. 
There are logical functions (and( ), or( ), etc.), text functions used to manipulate strings of text, math 
functions, date and time functions, display attribute functions (for changing text color,  text 
justification, etc.), and, of course, specialized functions for obtaining tally information.  
 
Embedded functions can be embedded within other functions. For example "add(1,sub(10,5))" will 
print  "6" .  
 
Also note that the function names are not case sensitive, i.e. add( ), ADD( ) and Add( ) all mean the 
same thing. 
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4.1 Commonly Used Functions 
 
The following functions are just a few of the more commonly used function. See the online help for a 
full list of embedded functions. 
 
ac(n),aj(n),af(n): text formatting functions for color, justification and font respectively. “n” is a 
numeric code which selects a particular attribute. Details of these codes can be found in the online 
help. Embedding one of these functions in text will affect all the text to the right of the function, up 
until either the end of the text, or until the function is repeated with a different attribute. For example 
“ac(85)REDac(255)AMBERac(170)GREEN” will display correctly colored names of the three 
colours available in an Image Video UMD, where 85, 170 and 255 are the Image Video UMD colour 
codes for red, green and amber respectively. Note that the effect of the text formatting functions are 
dependent on the type of display being configured. 
 
iv(n): reports either "1" or "0" to indicate the status of a GPI input. "n" is a number between 0 and 
511, and includes the inputs from one or more 4211 units. "n" can be calculated as follows: 
 
((DIP switch) x 8) + ((I/O connector) x 8) + (Channel in connector) where: 
 
• "DIP switch" is the DIP switch setting of a 4211 unit from zero to 255 
 
• "I/O connector" is a number from zero to four, in order of the connector numbering on the back of 

the 4211 unit. 
 
• "Channel in connector" is a number from zero to 7 in order of the pin numbering for the 4211 

inputs. 
 
For example, to sense the third input (input #2 starting from 0) on the second connector (connector #1 
starting from zero) of a box with a DIP setting of 5:  
 
(5 x 8) + (1 x 8) + 2 = 50. 
 
See Appendix A for a GPI address lookup chart. 
 
src(dest, index): "dest" is a resource output specified with the double-colon syntax (e.g. 
RTR::MON5). “Index” is a number starting from zero. The src( ) function is used to display a source 
on a given destination. “Index”  is used to select one of a number of selected sources to display. It can 
be used for real-world or virtual resource devices. 
 
Try the following. Open the "Configure Resources" dialog box. Enter "V1" in the name field and click 
on "Add". You have now created a virtual resource device. Click on "Output Control" and "Add" an 
output called "OUT1". In the "Control" field enter the name "INPUT2,INPUT4,INPUT6". Close the 
dialog box.  
 
Now click on a display  and enter "SRC(V1::OUT1,0)" The display will show "V1::INPUT2". Now 
enter "SRC(V1::OUT1,1)". The display will show "V1::INPUT4". Now enter "SRC(V1::OUT1,2)". 
The display will show "V1::INPUT6". The index chooses which of several possible inputs will be 



 Page 10   

shown. When we entered three input names separated by commas, the output in effect selected three 
inputs. We were then able to show the selected inputs using the SRC( ) function.  
 
Note that this will also work with real-world resource devices (i.e. a routing or switching device 
connected to one of the TSI serial ports or a set of GPI inputs). This is the basis of the way the tally 
system can be used to display routing information. 
 
One other thing to note about the src( ) function: this function will always try to find an originating 
source . If we build a system using resource interconnections and several layers of routing (i.e. a router 
feeding a router) and give the src( ) function a resource output with a source that arrives through a 
number of crosspoints, the function will display whichever source(s) it finds which have no origin, i.e. 
the origin of the signal. In other words, it will display only those resource inputs which are not fed by 
a resource output via a resource interconnection. 
 
 
 
 
 
 
 
 
 
xpt(dest): returns the crosspoint(s) taken on a resource output. Unlike the src( ) function, xpt( ) does 
not trace back beyond the input directly taken by the given resource output. Also unlike the src( ) 
function, the xpt( ) function returns the entire list of crosspoints selected by the resource output. 
Furthermore, there is a difference in the way the xpt( ) function behaves in the resource outputs, and 
the way it behaves when inserted in a tally display or GPI output. In resource displays and GPI 
outputs, the xpt( ) function returns the crosspoint name in double-colon format just like the src( ) 
function: e.g. RTR1::OUT1. In output controls, the resource device name and double colons are 
stripped off, leaving only the name of the resource input. This makes it easy to create a virtual 
resource output which follows another resource output, by simply inserting the xpt( ) command in it's 
control string. The xpt( ) function is the only function which will return the input directly taken by the 
given resource output without tracing back to the originating source. 
 
s(resource,fmt): The s( ) function is used to format a resource input or output name which has the 
double-colon format, in order to make it readable and "display friendly". "Resource" can be either a 
resource input or a resource output. "fmt" is one of the characters 0, 1, 2, 3, A, B. 0 and 1 can be used 
to return the native name of the resource (i.e. the name read directly from the resource device 
hardware or the input typed into a virtual resource output control). 2 or 3 returns the short and long 
name a ssigned to the resource in the Configure Resource Device dialog box. A and B return a name in 
accordance with the setting of the “Style” fields of the Configure Resource Device dialog box. Note 
that the s( ) function strips off the leading resource name and double colons and the trailing level 
specifier. 
 
pgm(src): The pgm( ) function is used to determine whether a source has gone to air. Given a source 
in the double-colon format, this function returns “1” if the source has been routed to an on -air resource 
output, otherwise it returns “0”. 
 
pst(src): The pst( ) function is the next -to-air analog of the pgm( ) function. 

RTR1::INP1  is fed by an 
originating source. 

Output RTR1::OUT1 feeds 
RTR2::INP1. 

SRC(RTR2::OUT1,0) will 
show "RTR1::INP1". 
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tsx(dest,fmt,pgm,pst,nrm): The tsx( ) is another function used to return the originating source on a 
given resource output (the “dest” para meter, in double-colon format), like the src( ) function. The tsx( 
) function is used only with resource outputs which select a single source at a time. Resource outputs 
which select multiple sources will have the highest priority source displayed. 
 
The ts x( ) function combines the functionality of the s( ) , pgm( ) and pst( ) functions. A typical 
example of it’s use in an Image Video UMD is “tsx(RTR1::OUT1,A,ac(85),ac(255),ac(170))”. The 
“fmt” parameter is equivalent to the “fmt” parameter in the s( ) function, and will cause the same 
formatting effects for the displayed source.  
 
The “pgm”, “pst” and “nrm” parameters are text which is inserted before the displayed source name, if 
certain conditions are met. Not that in the example we have chosen to insert color codes using the ac( ) 
function. The “pgm” (program) parameter is inserted before the source name if the source is on-air. 
The “pst” (preset) parameter is inserted before the source name if the source is next -to-air. The “nrm” 
(normal) parameter is inserted if the source is neither on-air, nor next -to-air. This has the effect, in the 
example case, of showing the name in red if the source is on air, showing it in amber if it is next -to-air 
and showing in it green if the source is neither of the above. 
 
 Two similar functions are the tss( ) and tsd( ) functions, which instead of showing the name of the 
source on a given resource output, show the name of a given source, or the name of a given destination 
respectively.  
 
The tss( ) (tally status for a sourc e) function can tally (i.e. change the color or show some other 
indicator) the displayed resource input name based on whether the given resource input is on-air or 
next -to-air.  
 
The tsd( ) (tally status for a destination) function can tally the displayed resource output name based 
on whether the source on the given resource output is on-air or next -to-air. 
 
sl(dest,fmt,len,pgm,pst,nrm): The sl( ) (source list) function is similar to the tsx function except that 
it will display a list of all of the sources selected on the given resource output, within the limits of the 
display. The meanings of the parameters are the same as for the tsx( ) function, with the addition of the 
“len” parameters, which specifies the total number of characters to display. The function will not show 
partial source names but will omit entire names at the end of the list, using the “len” parameter as a 
guide. The names are displayed in order of priority or in alphanumeric order. This function is most 
commonly used for displaying the status of program or preset buses on production switchers, which 
are capable of simultaneously selecting multiple sources.  
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5 Defining Resource Devices 
There are two classes of resource devices. Serial resource devices communicate with the TSI1000 via 
a serial port or network connection. Parallel resource devices communicate with the TSI1000 via 
parallel wiring and an Image Video General Purpose Interface unit (Model 4211). 

5.1 Defining and Testing Serial Resource Devices 
 
1. Press F1 to enter the online help and go to Tally System Design > Supported Resource Devices 

and read up on the router/switching devices of interest to your system. This will tell you important 
information about which ports may be used, the names or numbering scheme used for that 
particular router, serial baud rates, and so on. When selecting the port, keep in mind whether the 
device requieres an RS-422 or RS-232 port, or is on a network, and also note that COM1 and 
COM7 are reserved for the TSC and 4211s respectively. 

 
2. Open the Configure Resource Devices dialog box.  
 
3. Enter a name for the device in the Name edit field and press "Add". 
 
4. Click on "Port" and select the device type and select a port for the device. To assist you in 

selecting a port, take note whether the device requires RS232, RS422/485, SBUS or a network 
connection, and look up the port description table in the section "Tally System Interface 
Controller" in order to determine which port to use.  

 
5. If your device is a network device, such as the Grass Valley SMS-7000 router you will need to 

enter an IP address in the "Port" dialog box. If you are using a Sony router which uses an SBUS 
connection, there is no port selection to be made: the SBUS connection will be selected 
automatically. Only one SBUS router may be configured. 

 
6. Set the interface number for the TSI1000 to which the device will be connected. If you have only 

one TSI1000 in your system, leave "Interface" at 2. If you are using multiple TSI1000s with an 
Image Video Switchover Unit for redundancy, leave "Interface" at 2. If you are using multiple 
TSI1000s without a switchover unit, in order to interface a large number of external devices, then 
set "Interface" to match the interface number setting of the TSI1000 to which the new device will 
be connected.  

5.2 Testing Serial Resource Devices 
 
Once your device is configured and connected, check the relevant LED on the front of the TSI1000. If 
the LED is off, there is no device configured on that port. If the LED is red the device is configured 
but not communicating with the TSI1000. This  could be due to a cabling problem. If the LED is green, 
the device is communicating properly with the TSI1000. 
 
Certain devices allow the configuration of more than one device on the same port. In such cases it is 
possible for an amber LED to be displayed indicating that some but not all of the configured devices 
are in proper communication with the TSI1000. In the case of a network -connected device, such as the 
Grass Valley SMS-7000 router or multiple TSI1000s, the amber LED on the "Ethernet" LED indicates 
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that one of the configured devices is offline, while a red LED indicates that either all the configured 
devices are offline, or that the network is disconnected or not in operation. 
 
Some routing or switcher devices require the configuration of at least one resource output in order to 
begin communications with the external device. If you don't have a configuration ready to try out yet, 
just add a control string to a display or a GPI output which references a resource output on the device 
in question, such as, for example, "src(R1::002[1])". Make sure that the resource output name you use 
is valid for the device by checking the specific help article for that device (F1 (help) > Tally System 
Design > Supported Resource Devices). 

5.3 Defining Parallel Resource Devices 
 
1. Open the Configure Resource Devices dialog box. 
 
2. Enter a name for the device in the Name edit field and press "Add". 
 
3. Click on "Port", select the "Virtual" device type, (this is the default setting for a new device) and 

select "Close". 
 
4. Click on "Output Control", select the name of the resource device, then "Add" a new device with a 

short descriptive name. 
 
5. In the control section, if you have defined your GPI inputs to be consecutive, you may enter the 

following control string, or something similar (exclude quotes): "i2n(40,32,1)". In this example, a 
range of GPI inputs starting from the 40th input and including 32 inputs from 40 to 71 are assigned 
to represent a set of 32 consecutive inputs numbered starting from one. (NOTE: add a part about 
name formatting). 

 
For example, if the above control string is used to form a virtual resource output named 
V1::OUT1, then the control string src(V1::OUT1) entered into a display will show "V1::1" 
whenever the 40th GPI input is activated. The 41st GPI input cause an indication of "V1::2", etc. If 
both the 40th and the 41st GPI inputs are activate then a indication of "V1::1 V1::2" would be 
shown. 

 
6. We now have a set of inputs which can be display numerically. Those inputs which are uniquely 

associated with sources in the system (i.e. the sources on these inputs which are not also fed to 
some other resource input in the system,) can be given long and short source names. See the 
section on "Defining Source Names. 

 
7. Those inputs which are fed by sources which also feed o ther resource inputs elsewhere in the 

system can be connected to common sources. See the section on "Defining Common Sources". 
 
For situations where GPI inputs are not consecutively numbered, other control strings can be created 
to handle those cases. Consecutively assigned GPI inputs are not only easier to program, they are also 
more efficiently evaluated by the TSI1000 under operational conditions.  
 Deleted: Page Break
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6 Defining source names 
 
Names used at the engineering level to denote router and switcher inputs and outputs are rarely useful 
to the system operators. For example an engineering input name such as “CAM4” or “10” would 
likely be required to be displayed in a tally system in a more verbose format, such as "Camera 4 
(Bob)". In the Image Video tally system there is a table associated with each resource device which 
can be used to assign displayable names to each resource input or output. Output names are rarely 
required to be displayed in tally system, so we will concentrate on source names here. 
 
To enter a displayable source name 
for a particular resource input: 
 
1. Open the Configure Resource 

Devices dialog box. 
 
2. Click on "Add Resource Item". 

Enter the native name of the 
input you are renaming. The 
format of this name is dependent 
on the device type. Some native 
names will be numeric, others 
will be numeric with leading 
zeroes, others will be 
alphanumeric. Virtual resource 
input names which are created 
using the i2n( ) function are 
usually numeric without leading 
zeroes. Check the help on the 
particular device type to find out 
the format of this name. 
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3. When the resource item has been added, fill the required display name into the "Short Name" and 

"Long name" edit fields. The "Style A" and "Style B" fields can usually be left as is. 
 

The "long" and "short" names can be selected for display by a format parameter passed to such 
functions as the "s( )" function, and the tsx( ), tss( ) and sl( ) functions. The possible values of  the 
format parameter used with these functions, and their effects are as follows: 
 

Format parameter value Display effect 
1 Display the native name (usually numeric or a mnemonic). 
2 Display the short name  
3 Display the long name  
A Display the style set by "Style A" for the resource item in 

the Configure Resources dialog box.  
B Display the style set by "Style B" for the resource item in 

the Configure Resources dialog box.. 
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7 Defining Interconnections 
In order to correctly model a routing system, it is necessary to be able to define interconnections which 
join routing matrices. An interconnection from a resource output to any number of resource inputs can 
be defined in the Image Video tally system. 
 
To define an interconnection: 
 
1. Open the Resource 

Interconnection dialog box.  
 
2. "Add" a resource 

interconnection name. 
 
3. Type the name of the 

resource output into the 
"Origin" edit field, in double -
colon format. 

 
4. If the purpose of the resource 

interconnection is to register 
an on-air or a next -to-air 
output, check the appropriate 
box.  

 
5. Type the name of a resource input into the "Ends" dialog box, also in double -colon format. "Add" 

name to the "Ends" list, and add other ends as required. Note that is not necessary to assign ends to 
resource interconnections which are used to register on-air or next -to-air outputs, although it is 
permissible. 

 
6. Close the Resource Interconnections dialog box. 



 Page 17   

 

8 Defining common sources 
 
A common source is a source which feeds more than one resource input. Common sources must be 
handled in special way in the Image Video tally system, in order to allow for the possibility that a 
source may be taken to air through a number of different paths.  
 
Suppose that a source called CAM3 feeds an input of a router as well as the input to a switcher, and 
further suppose that the router has an output which feeds the switcher. We could define an resource 
input on each of the router and switcher, both of which inputs could have the long and short name 
"Camera 3". Now suppose that the switcher input for "Camera 3" is taken to air, and that a router 
destination (say a monitor output called MON5) also takes it's own "Camera 3" input. Because of the 
way the TSI1000 traces paths from the on-air output to the a source to determine whether that source 
is on-air, the system would not be aware that the two "Camera 3" inputs are in fact connected to the 
same source, and Camera 3 would not be tallied on-air (say with red text) on the MON5 UMD. 
 
Therefore, for tally consistency, it is often preferable to configure common sources so that they are 
tied to some common input, which can then be given the long and short display name. 
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Common Sources 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Camera 3 to router 
is a router input with 
long/short name 
"Camera 3" 

Router 
Switcher 

On-air output  

Router 
Switcher 

On-air output  

Virtual Device 
Virtual output 
CAM3  
permanently 
"takes" virtual 
input CAM3. 

Camera 3 to virtual 
device is a virtual 
input CAM3 with  
long/short name 
"Camera 3" 

Resource Interconnection: Origin is 
virtual output CAM3, Ends are 
switcher CAM3 input and router 
CAM3 input. 

By Making Camera 3 a common source to the switcher and router, whether it is on-air 
directly through the switcher or indirectly through the router, it will be tallied on-air 
wherever it is displayed.  

If Camera 3 to the switcher goes to air, Camera 3 to the router will not be tallied when it is 
displayed, because, as far as the tally system knows, it is a separate input. 

Camera 3 to switcher 
is a switcher input 
with long/short name 
"Camera 3" 
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8.1 Defining Common Sources 
 
To set up a number of common sources: 
 
1. Open the Configure Resource Devices dialog box. Enter the name for a new virtual device and 

"Add" it.  
 
2. Click on "Port" and set the "Type" to "Virtual". Close the "Port" dialog box.  
 
3. Click on "Output Control" to open the Resource Output Control 

dialog box. Select the name of the new virtual device. "Add" a 
series of outputs, giving them each a mnemonic that reflects the 
function of the common source. This not what will be displayed for 
the source name, so you can use something simple and descriptive, 
like CAM1, CAM2, VTR1, VTR2, etc. The dialog box will give 
you an incrementing default value which is helpful for entering 
these sorts of mnemonics.  

 
4. Note that the "Control" field is 

automatically filled in with the 
output name as your create each 
output. Leave the value of the 
control field in that state. This means 
that the virtual output will have a 
permanent "take" on an input of the 
same name. (The mnemonics for the 
input and output don't have to be the 
same, but it makes it easier to keep 
track of things). 
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5. Once all of the common sources 

you wish to enter are represented 
in the Output Control dialog box, 
you may close it.  

 
6. You should now be back to the 

Configure Resource Devices dialog 
box. We will now enter short and 
long names for each common 
source. Click on the name of the 
virtual device then click on "Add 
Resource Item". For the "Name" 
use the same mnemonic name for 
each source as we used to create 
the outputs in the Output Control 
dialog Box. Make sure that each 
source has the "Source" box 
checked. For each source, also add 
the short and long name which 
should be displayed for the  source. 

 
7. Once all of the common source 

short and long names are added,  close the Configure Resource Devices dialog box.  
 
8. Open the Configure Resource Interconnections dialog box. For each common source "Add" a 

resource interconnection, using a name descriptive of the common source being entered (you could 
use the mnemonic for the common source's virtual output). For the origin of each interconnection, 
enter the mnemonic that we created for the common source's virtual output, in double -colon 
format. For example if the name of the virtual device was V1, and the mnemonic for a common 
source was CAM1, then the origin of the resource interconnection will be V1::CAM1. 

 
9. For each resource interconnection, 

now enter the "ends", in double-
colon format. For example if 
common source CAM1 feeds 
switcher S1's input "1", and also 
feeds router R1's input "005[1]", then 
the two ends added would be S1::5 
and  R1::005[1]. Be sure to press the 
"Add Ends" input for each "Ends" 
entry. You can have any number of 
ends for each resource 
interconnection. Once one resource 
interconnection has been completed 
for each common source close the 
Configure Resource Interconnections 
dialog box. 
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10. We have now completed the entry of the common sources. For each common source we have 
created a signal path from a virtual input, which has a mnemonic name and a displayable short and 
long name, through a virtual output of the same mnemonic name. This virtual output with a fixed 
input status is fed via a resource interconnection to a number of resourc e inputs.  

 
Now whenever any destination takes an input being fed by the common source, the signal path is 
traced back to the virtual input, and the long or short name programmed for the virtual input will 
be displayed. Similarly, if an on-air or next-to-a ir destination takes an input being fed by the 
common source, the signal path is traced back to the virtual input and the virtual input is marked as 
being on-air or next -to-air; therefore any other destination which takes the common source will 
also be pro perly tallied as on-air or next -to-air. 
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9 Programming Displays 
 
1. Open the Configure Display Units dialog box. For each display in your system, “Add” a name and 

enter it’s serial number. The display name is arbitrary, but can be named after a rack location o r be 
descriptive of it’s purpose in your system.  

 
Note the following regarding serial numbers: 

 
Display Type Note 
RDU15xx series  Serial number must match number on unit. 
RDU11xx series  Serial number must have three digits and match DIP switch 

setting. 
Kaleido, Zandar Serial number is arbitrary but must be unique (use the default 

suggested by editor) 
 
2. For Image Video displays, set the “W idth” and “Monitor” settings according to the unit’s size and 

whether the unit is single, dual or triple. 
 
3. Close the Configure Display Units dialog box. For each display, select F6 to select each display, 

close the selection box and press CTRL -W. Press “1”, “2’ or “3” to select whether the display is a 
single, dual or triple and press ENTER.  

 
4. To program the contents of a display, use F6 to select the display, then click in the middle of the 

display. An alternative method of entering a display string is to open the Configure Displays dialog 
box, select a display name then click on "details".  

 
Although text displays can be programmed in literally thousands of different ways, because of the 
flexibility of the control language, we will present here a number of the most commonly used 
configurations: 

 
Display function Control string for Image Video UMD 

Static text "Welcome to Studio 1" in green Welcome to Studio 1 
Static text "Welcome to Studio 1", center-
justified and in red . Note that the center-
justify command aj(1) will be used more 
often than not in typical displays, but it is 
omitted from the other examples for clarity. 

aj(1)ac(85)Welcome to Studio 1 

Static text "CAM1" in red when source 
S1::1 goes to air, otherwise green. 

if(pgm(S1::1),ac(85),ac(170))CAM1 

Static text CAM1 in red when source S1::1 
goes to air, in amber if it is on preset, 
otherwise green. 

if(pgm(S1::1),ac(85),if(pst(S1::1),ac(255),a
c(170)))CAM1 

Display source R1::001[1] in Style A, 
tallying it red if it goes to air, tallying it in 
amber if it is next -to-air, otherwise green. 

tss(R1::001[1],A,ac(85),ac(255),ac(170)) 

Display source on destination R1::005[1] in tsx(R1::005[1],A,ac(85),ac(255),ac(170)) 
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Style A, tallying it red if it goes to air, 
tallying it in amber if it is next -to-air, 
otherwise green. 
Show a source list for destination 
S1::PGMOUT, with sources shown in Style 
A, allowing up to 26 characters tallying it 
red if it goes to air, tallying each source in 
amber if it is next -to-air, otherwise green. 

sl(S1::PGMOUT,26,A,ac(85),ac(255),ac(17
0)) 

Show a source list for destination 
S1::PGMOUT, with sources shown in Style 
A, allowing up to 26 characters, but leave 
the display always green (no tally). 

sl(S1::PGMOUT,26,A) 

Show different static text depending on the 
state of the 20th GPI input. Note that text 
which includes spaces must be surrounded 
with double-quotes. 

if(iv(19),"ON AIR","OFF AIR") 

Show text alternating between two 
messages every 1/2 second (50 hundredths 
of a second). Note that up to three different 
"lines" of alternating text are allowed. 

lin(1)dur(50)"Studio 1"lin(2)dur(50)"On 
Air"  

Show text alternating between two 
messages every 1/2 second (50 hundredths 
of a second) if GPI input 10 is active, 
otherwise show only the first line. 

lin(1)dur(50)"Studio 
1"lin(2)dur(if(iv(9),50,0))"On Air"  

Select a resource output tally based on the 
state of the 5th GPI input. Note that the 
name of a destination is saved in variable 
"!D" and read back out of variable "!D" by 
the tsx( ) function. This control string is 
useful for switching monitor walls.  

sv(!D,if(iv(4),R1::001[1],R1::020[1])tsx(v(!
D),A,ac(85),ac(255),ac(170)) 

Select a resource output tally based on the 
state of a switcher bus. Here if a switcher 
bus takes input 5, router output 001[1] is 
monitored, otherwise router output 020[1] is 
monitored.  

sv(!D,if(eq(src(S1::OUT),S1::5),R1::001[1],
R1::020[1])tsx(v(!D),A,ac(85),ac(255),ac(1
70)) 
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10 Programming GPI outputs  
 

10.1 Single-element control 
 
To control GPI outputs which become 
active when  certain conditions are met 
(e.g. when a source goes to air): 
 
1. Open the Configure GPIs dialog 
box. For each GPI output, "Add" a 
descriptive "Name" for your GPI 
output. Leave "Interface" and "Port" at 
2 and COM7 respectively.  
 
The "Base" value is a GPI address, 
which is calculated in the same way as 
the GPI input address used in the "IV( 
)" function: 
 
((DIP switch) x 8) + ((I/O connector) x 
8) + (Channel in connector) where: 
 
• "DIP switch" is the DIP switch 

setting of a 4211 unit from zero to 
255 

 
• "I/O connector" is a number from zero to four, in order of the connector numbering on the back of 

the 4211 unit. 
 
• "Channel in connector" is a number from zero to 7 in order of the pin numbering for the 4211 

outputs. 
 
See Appendix A for a GPI address lookup chart. 
 
2. In the "Control" edit field enter one of the following control strings, depending on the desired 
functioning of the GPI output: 
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GPI requirement Control String 
1. The GPI must be permanently on (useful 

for test) 
1 

2. The GPI must be permanently off (useful 
for test) 

0 or leave field blank 

3. Activate GPI when source R1::SRC1 goes 
to air 

pgm(R1::SRC1) 

4. Activate GPI when the source on 
destination R1::DST1 goes to air. 

pgm(src(R1::DST1)) 

5. GPI output should follow the 10th GPI 
input. 

iv(9) 

6. GPI output should activate if any of GPI 
inputs 0 to 3 are active.  

or(iv(0)iv(1)iv(2)iv(3)) 

7. GPI output should activate if all of GPI 
inputs 0 to 3 are active. This could also be 
done using three embedded AND 
functions. 

eq(iv(0)iv(1)iv(2)iv(3),1111) 

8. GPI should activate if source R1::CAM1 
appears at any one of destinations 
R1::VTR1, R1::VTR2, R1::VTR3. This 
can be used to form an "iso-tally" (used to 
inform a cameraman he is being recorded). 
"sid" stands for "source in destinations".  

sid(R1::SRC1,R1::DST,R1::DST2, R1::DST3) 

9. A variation of the above iso-tally, in which 
the tally does not appear if the camera is 
on-air. 

eq(sid(R1::SRC1,R1::DST,R1::DST2,R1::DST3)pgm(R1::SRC1),10) 

 
Note that, for reasons explained in the next section, that single element control strings must always 
resolve to the number "1" or "0". If it is required that any number greater than zero turn on the GPI 
output, then use the "greater than" function, as in example 6 above. For example the number "24" in 
the control field will turn the control off, "25" will turn it on, but gt(24,0) and gt(25,0) will both turn 
the output on. Of course it is more likely that an imbedded function returning a range of numbers 
would be used in place of the numbers in the above example. 

10.2 Multi-element GPI control 
 
 Multi-element controls are rarely used in common tally operations, but understanding how they work 
can help one to better understand GPI output control in general, in order to avoid common pitfalls 
encountered in even single -element controls. 
 
In the previous section we treated GPI outputs as they are most commonly used: as single-bit values 
controlling a single hardware output. In such cases the "size" field is set to 1. Furthermore, in such 
cases of single element control, the control string must resolve to either the number "1" ( the "on" 
condition for a single element control, or the number "0" (the "off" condition for a single element). 
 
If however the "size" field is set to a number greater than one, then several contiguous outputs can be 
controlled by the control string within a single GPI output control. The control field of a GPI output 
evaluates a number as a binary value. The number 0 is evaluated as binary "0". The number 1 is 
evaluated as binary "1". The number 2 is evaluated as binary "10". In this case, if the size field is set to 
two, then a contiguous pair of  GPI outputs are controlled, with the highest numbered output being 
turned on by the most significant bit of binary "10"and the lowest-numbered output being turned off 
by the least significant bit of binary "10". 
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The “size” field instructs the TSI1000 to consider a certain number of contiguous bits within the 
binary representation of the given value, starting with the least significant bit. Higher bits are ignored. 
Note that this means that, for example, with a size of 1, that the number 24 in the control field, which 
is binary 11000, will turn off it's single output, (lowest bit is zero ) while 25 (binary 11001) turns on it's 
single output. 
 
The "base" field sets the starting output for the contiguous set of controlled outputs. 
 

Examples of multi-element GPI output control 
Base Size Control field Binary value  Effect 
0 2 2 10 Turns on second output 
0 2 3 11 Turns on first two outputs  
5 4 15 1111 Turns on outputs 5,6,7,8. 
5 4 iv(0)iv(1) Possible values, 

depending on the 
state of the first two 
GPI inputs, are 
decimal 00,01,10, 
or 11, (binary 
0000,0001,1010,or 
1011). 

With least significant (right-most) 
binary bit corresponding to output 5, 
we find that outputs 5-8 will either 
be all off, or 5 only on, or 6 and 8 
on, or 5, 6 and 8 on. Lesson: control 
field values are read as decimal 
numbers but evaluated as binary 
numbers.  

0 4 or(iv(0)iv(1)iv(2)iv(3)) Depends on state of 
first four GPI inputs 

First output will turn on if any of 
inputs 0,1,2,3 are active. Second, 
third and fourth outputs are not 
affected. 
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11 GPIs in TSI1000 Version 1.84 and higher 
 
 
The following describes how to set up General-Purpose Interface (GPI) ports on versions of the 
TSI1000 from V1.84 and higher. 
 
New GPI configuration methods for setting up GPI ports introduced in TSI1000 V1.84 are required 
only in cases where the Image Video Remote Panel port is used (for example to use the RCP40 or 
VxV16 control panels) or in cases where multiple Model 4211 ports are being used. 

11.1 Overview 
 
The TSI1000 after version 1.84 supports up to 4096 GPI inputs and outputs. Image Video Model 4211 
general purpose inputs and outputs, and "Remote Panel" (IVRP) inputs and outputs both "map into" 
this same space. Up to 512 GPI inputs and outputs can be monitored on a single 4211 or IVRP port. 
 
GPI inputs are read using either the "iv()" function, or the "i2n()" function, and the full range of GPI 
inputs monitored by these functions are identified by numbers ranging from 0 to 4095. 
 
For either in 4211 units or in IVRP units, GPI outputs are each identified by two pieces of 
information: the port that the device is being monitored on, and a number between zero and 511. 
 
In this discussion, a "4211 port" is a port defined to operate Image Video 4211 GPI I/O boxes. An 
"IVRP port" is a port defined to operate Image Video RCP-40 Remote Panels and other devices 
compatible with the IVRP protocol. Because both 4211 ports and IVRP ports map into the GPI input 
and output address space, then a "GPI port" refers to a port that is either a 4211 port or a IVRP port. 
 

11.2  Setup Procedures 
 
Configuration of  a GPI output is performed in the "Resource" -> "Configure GPIs" dialog box. The 
TSI1000 Interface Number, the GPI output COM port, the starting GPI output address (starting at zero 
for each port) and the number of physical GPI outputs controlled (usually 1) must be specified. 
 
Configuration of  a GPI input base address is performed in the "Resource" -> "Configure GPIs" dialog 
box. The TSI1000 Interface Number, the port COM-number and the base address for the port must be 
specified. The base address must be a multiple of 8 
 
Configuration of  an IVRP port is performed by specifying a resource device of "Type" "Image Video 
Remote Panel" in the "Resource" -> "Configure Resource Devices" dialog box. Click on "Port" to set 
the location of the IVRP port (specify an Interface Number and a port number). Once the port is set 
up, an "output control" must be defined for each panel connected to the port. 
 
Configuration of  an Image Video Remote Panel is performed after the IVRP port is defined, (see 
above), in the "Resource" -> "Configure Resource Devices" -> "Output Control" dialog box. Click on 
the IVRP resource device in the "Configure Resource Devices" dialog box "Name" list, click on 
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"Output Control", then, for each panel, fill the serial number of the panel into the "Output" field, and 
fill the GPI address of the panel into the  "Control" field. This GPI address directly defines the GPI 
output number of the first output in the panel, and, when added to the GPI input base address for the 
port, also defines the GPI input number of the first input in the panel. 
 

11.3  When does a GPI port get set up ?  
 
In general, GPI port is set up whenever the "iv()" or "i2n()" command is used in the configuration, or 
when a GPI output is set up, or whenever "Image Video Remote Panel" resource device is set up. The 
GPI Input Base Address specifies which GPI input addresses will address the devices on each port, 
will not in and of itself set up a GPI port. 
 
1. In the absence an any GPI outputs, GPI input base addresses, or IVRP ports, a 4211 port is set up by 
default on COM7 if the "iv()" or "i2n()" function is used anywhere in the configuration. 
 
2. A GPI port (either IVRP port or 4211 port) is set up if a GPI output is configured on a given port. If 
there is a "Image Video Remote Panel" resource device set up on the given port, the port will be an 
IVRP port, otherwise it will be a 4211 port. 
 
3. If no GPI input base address is specified for any port, and exactly one GPI port has been specified 
via GPI outputs or an "Image Video Remote Panel" resource device, then either a 4211 port or a RPP 
port will be set up, and the GPI inputs for the port are accessed with GPI input addressed starting from 
zero. 
 
4. If no GPI input base address is specified for any port, but exactly one RPP port and exactly one 
4211 port has been set up, then the 4211 port's inputs are accessed with GPI input addressed starting 
from zero, and the RPP port's inputs are accessed with GPI inputs addressed starting from 2048 (one-
half of the 4096 GPI inputs and outputs available on a TSI1000). 
 
5. For combinations or numbers of 4211 and GPI ports other than those described in points 3 and 4 
above, a GPI input base address must be specified for each GPI port. 
 

11.4  GPI Port Address Mapping 
 
The 4211 port and RPP port GPI input and output addresses are mapped as follows: 
 
For 4211 GPI outputs: Address = 4211 DIP switch setting multiplied by 8, plus the 4211 output 
channel number (typically 0-39). 
 
For 4211 GPI inputs: Address = the port’s GPI input base address, plus 4211 DIP switch setting 
multiplied by 8, plus the 4211 input channel number (typically 0-39). The port’s GPI input address is 
set in “Resource” -> “Configure GPIs” -> “GPI Inputs” -> “Base Address”. 
 
For RPP port GPI outputs: Address = RCP panel’s GPI address plus the RCP panel output LED 
number (typically 0-29 or 0-39). The RCP panel’s  GPI base address is set in the “Resource Device" -> 
“Output Control” -> “Control" field. 
 



 Page 29   

For RPP port GPI inputs: Address = the port’s GPI input base address, plus the RCP panel’s GPI 
address, plus the RCP panel button number (typically 0-29 or 0-39).  
 
GPI input addresses are typically used in IV( ) or I2N( ) embedded functions, with valid values from 0 
to 4095. The range of valid GPI input numbers are inclusive of the inputs on all GPI ports.  
 
GPI output addresses are used to program the “Address” field in the “Resource” -> “Configure GPIs” 
dialog box, with valid values from 0 to 511 for each GPI port. While each port can support up 512 GPI 
outputs, sets smaller than 120-200 outputs per port are preferred. 
 

11.5  RPP Port Device Mapping 
 
Devices on an RPP port are mapped into the GPI address space using "Output Controls" defined for 
the "Image Video Remote Panel" resource device. The name of each output control is a numeric 
decimal value designating the serial number of the device, and the "Control" field of each output 
control is a numeric decimal value designating the mapping of the device into the GPI address space. 
 
Example 1:  
 
Set up a single RPP port on COM8, with no other GPI ports, and no GPI Input Base Address. Create 
the following output controls: 
 
Name=12345 (serial number) control=0 (device base address) 
Name=12346 (serial number) control=40 (device base address) 
Name=12347 (serial number) control=80 (device base address) 
 
Then the device I/O mapping will be: 
 
Panel 12345 Input Mapping: GPI input addresses 0-39 
Panel 12346 Input Mapping: GPI input addresses 40-79 
Panel 12347 Input Mapping: GPI input addresses 80-511 
 
Panel 12345 Output Mapping: COM8 GPI output addresses 0-39 
Panel 12346 Output Mapping: COM8 GPI output addresses 40-79 
Panel 12347 Output Mapping: COM8 GPI output addresses 80-511 
 
Note that the address range of the last device on each port extends to the 512th input or output (#511), 
since by definition the address range of the last device is not bounded by the starting address of a 
higher-addressed device. No single IVRP device/panel can have more than 512 inputs or outputs.  
 
Example 2:  
 
Set up two single RPP ports on COM8, with a GPI Input Base Address of zero and COM9, with a GPI 
Input Base Address of 160, with no other GPI ports: 
 
Create the following output controls on COM8: 
 
Name=12345 (serial number) control=0 (device base address) 
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Name=12346 (serial number) control=40 (device base address) 
 
Create the following output controls on COM9: 
 
Name=12347 (serial number) control=0 (device base address) 
Name=12348 (serial number) control=40 (device base address 
 
Then the device I/O mapping will be: 
 
Panel 12345 Input Mapping: GPI input addresses 0-39 
Panel 12346 Input Mapping: GPI input addresses 40-79 
Panel 12347 Input Mapping: GPI input addresses 160-199 
Panel 12348 Input Mapping: GPI input addresses 200-511 
 
Panel 12345 Output Mapping: COM8 GPI output addresses 0-39 
Panel 12346 Output Mapping: COM8 GPI output addresses 40-79 
Panel 12347 Output Mapping: COM9 GPI output addresses 0-39 
Panel 12348 Output Mapping: COM9 GPI output addresses 40-511 
 
NOTE that the output mapping restarts at zero for each port, because we specify both a port and a GPI 
output address for each GPI output set up. But the input mapping is a continuous range of numbers 
over the entire TSI1000 GPI address space, because no port number is specified when using the 
"i2n()" or "iv()" functions to read GPI inputs. 
 
Example 3:  
 
Set up a single 4211 port on COM7, and an RPP port on COM8, with no GPI Input Base Addresses 
specified: 
 
Create the following output controls on COM8: 
 
Name=12345 (serial number) control=0 (device base address) 
Name=12346 (serial number) control=40 (device base address 
 
Then the device I/O mapping will be: 
 
4211 Input Mapping: GPI input addresses 0-511 
4211 Output mapping: COM7 GPI output addresses 0-511 
 
Panel 12345 Input Mapping: GPI input addresses 2048-2087 
Panel 12346 Input Mapping: GPI input addresses 2088-2599 
Panel 12345 Output Mapping: COM8 GPI output addresses 2048-2087 
Panel 12346 Output Mapping: COM8 GPI output addresses 2088-2599 
 
NOTE that in this case the two ports have been mapped by default at zero and 2048. 
 

12 Programming Resource Output Controls 
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Resource outputs using have an input selection state based on information received from an associated 
external device. For example an external Philips router may control the input selection of a resource 
output called R1::001[1]. However it is also possible to set up virtual resource outputs whose input 
selection is determined by information generated within the TSI1000 itself. This is accomplished by 
using an "output control". 
 
There are two types of output controls: virtual output controls and non-virtual or "real" output 
controls. A virtual output control is simply an output belonging to a virtual resource device (i.e. a 
resource device not directly associated with any external hardware). A real output control will actually 
generated a switch or a "take" message to the external hardware associated with the resource device. 

12.1  Virtual Output Controls 
 
Virtual output controls are typically used to tally GPI-driven switcher or to select emergency program 
buses, though they can be used for many other applications. 

12.1.1 Programming a GPI-driven Virtual Device 
 
1. If you are using a GPI-driven switcher which provides a single contact out for each input selected, 

click on the “Output Controls” button in the Configure Devices dialog box, and select the switcher 
name in the “Resource” list.  

 
2. “Add” an output with a descriptive name (e.g. PGMOUT). Under “Control” enter the i2n( ) 

function as described in the section on “Commonly Used Functions”. You will need to specify a 
starting GPI input, the number of GPI inputs used to tally the switcher, and a starting number for 
the switcher to be reported on (usually 1). Example: i2n(40,20,1) will create a resource output 
whose status will be determined by a set of 20 GPI inputs starting at the 41st input, where the 
activation of the 41st input will cause input "1" to be "taken" on the output, the 42nd input will 
cause input "2" to be taken and so on. Multiple inputs may be selected simultaneously. 

 
NOTE: your GPI inputs must be assigned consecutively for this method to work. Other GPI 
assignment schemes can be accommodated by programming a slightly more complex control 
string. 

 

12.1.2 Programming an Emergency Bus 
 
Emergency program buses are often implemented to cover the case of a production switcher going out 
of service during a critical broadcast interval. Usually a router bus is assigned to take over from the 
switcher program bus in the event of a switcher failure. The TSI can be informed of this event, so that 
it can account for emergency conditions in it's tally displays and outputs. This information can be 
transferred to the TSI1000 via a GPI input, or the TSI1000 can follow a router bus which is used to 
switch between the switcher program bus and the emergency router bus.  
 
The programming for an emergency bus can be illustrated as follows: 
 
 
 Switcher program output 

This resource output, which could be 
either virtual or real, selects either the 
switcher or router emergency output. 



 Page 32   

 
 
 
 
 
 
 
 
 
 
 
 
 
A source traced through either the switcher program bus or the emergency bus to the "On-air 
interconnection will be considered on-air, depending on the input selected by the output feeding the 
"On-air" interconnection. 
 
To program a GPI-selected emergency program bus: 
 
1. Press Ctrl-F9 to open the "Configure Resource Devices" dialog box.  
 
2. Open the Configure Resource Devices dialog box.  
 
3. Enter a name, such as "V1" for the virtual device in the "Name" edit field and press "Add". 
 
4. Click on "Port", select the "Virtual" device type, (this is the default setting for a new device) and 

select "Close". 
 
5. Click on "Output Control", select the "V1" resource device, then "Add" a new resource output with 

a descriptive name such as "PGMOUT". 
 
6. In the "Control" field add the control string: if(iv(0),EMG,SWR). When the first GPI input (input 

"0") is activated, the EMG input of virtual device will be selected, otherwise the SWR input will 
be elected. Use some number other than zero if a different GPI input is preferred. 

 
7. Close the "Output Control" and "Configure Resource Devices" dialog boxes. 
 
8. Press Ctrl-Shift-F9 to open the "Resource Interconnections" dialog box. 
 
7. "Add" resources interconnections as  per the following table (names are arbitrary, use your own as 

required). For details on how to enter the interconnection information, see the section on 
"Programming Interconnections". 

 
Name of 

interconnection 
Origin End Comment 

EMG-RTR R1::EMGOUT V1::EM G Normal on-air path 
NRM-SWR SWR::PGM  V1::SWR Emergency on-air path 
PGMOUT V1::PGM (none) Check the "on-air" box. 

 

 

Emergency router bus 

"On-air" interconnection. 

Emergency/Normal select 
interconnections  
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Note that in the above example the emergency router output is on a real resource device called R1 
and the emergency router output is "EMGO UT". The normal switcher program bus is SWR::PGM. 
The system program out is V1::PGM and any source traced to this resource output will be 
considered on-air because of the "PGMOUT" on-air interconnection. 

 
8. Close the Resource Interconnections dialog box. 
 
To program a Router-selected emergency program bus: 
 
Suppose that instead of using a GPI input to inform the tally system or an emergency condition we 
instead have a separate router bus which selects either the switcher program bus or router emergency 
bus in order to feed the final on-air path. In this case we don't need the virtual output and this can be 
entered as follows: 
 
1. Press Ctrl-Shift-F9 to open the "Resource Interconnections" dialog box.  
 
2. "Add" resources interconnections as per the following table (n ames are arbitrary, use your own as 

required). For details on how to enter the interconnection information, see the section on 
"Programming Interconnections". 

 
Name of 

interconnection 
Origin End Comment 

EMG-RTR R1::EMGOUT R1::EMGIN Emergency on-air path 
NRM-SWR SWR::PGM  R1::SWRIN Normal on-air path 
PGMOUT R1::PGMOUT (none) Check the "on-air" box. 

 
Note that in the above example the emergency router output is on a real resource device called R1 
and the emergency router output is "EMGOUT". The normal switcher program bus is SWR::PGM. 
The system program out is router output R1::PGMOUT, marked by the "On-air" resource 
interconnection PGMOUT . 
 

3. Close the Resource Interconnections dialog box. 

12.2 Real Output Controls 
 
Output controls can also be used to issue takes to routing hardware. The procedure for setting up a real 
output control is similar to that for setting up a virtual resource output control. A typical application 
for real output controls would be to switch one or more monitor buses, based on a GPI input or the 
state of a master control switcher bus. 
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12.2.1  Overview 
 
Real output controls should be used with care, as they are performing takes on routing systems which 
could have an on-air effect. New output controls should be tested off-air first to make sure they work 
correctly, as a mistake in the control string can cause either no effect or an unintended effect.  
 
The TSI1000 performs takes by evaluating a control string associated with the given real resource 
output: when the evaluated control string changes, then a take is issued to select the new input name 
generated by the control string. If the evaluated control string has changed to a an empty string, then 
no action is performed.  
 
If the take fails for some reason, (possibly because of an incorrect control string, or because of a router 
system restriction), the TSI1000 will usually (depending on the type of router being switched) retry a 
three times on 1/2 second intervals, then give up. After the TSI1000 has finished it's selection process, 
the bus can be switched freely at router panels without effect on or intervention by the TSI1000.  
 
When the TSI1000 restarts, the TSI1000 evaluates all of it's control string once without performing 
any switches. Switches are disabled for 30 seconds after the TSI1000 has started up, to disallow the 
possibility of unexpected takes occurring due to startup conditions. Thereafter any changes found in 
evaluated router output control strings will result in takes being sent to the associated router buses. 
 
To prevent real router output controls from being accidentally created, a special control string is 
required to be inserted at the beginning of the control string field to enable the control function. The 
TSI1000 checks for the presence of the special control string to determine whether to proceed with the 
switch operation, then goes on to process the remainder of the control string to determine which input 
is to be switched.  

12.2.2 Programming Follower Buses 
 
To program a router bus to follow another router bus (in this example R1::001[1] will follow 
R1::005[1]): 
 
1. Press Ctrl-F9 to open the "Configure Resource Devices" dialog box.  
 
2. Click on "Output Control", select the "R1" resource device, then "Add" resource output 001[1] . 
 
3. In the "Control" field add the control string: sv(*RE,ROC_TAKE)xpt(R1::005[1]). 
"sv(*RE,ROC_TAKE)" is a keyword to enable takes on this bus, to prevent take operations from 
being programmed accidentally. The "XPT" function will return the input taken by resource output 
R1::005[1].  
 
When the value returned by the XPT function changes, the TSI1000 will use the new value to issue a 
take to the following router bus. Devices external to the TSI1000 (such as a router control panel) may 
control the  bus separately without interference from the TSI1000. 
 
4. Close the "Output Control" and "Configure Resource Devices" dialog boxes. 
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Note that in this case, the take is being done on the same router, so the value returned by the XPT 
function is compatible with the value required for the take. Often a router bus must follow a  bus from 
a totally different router family. For example a router using a mnemonic input and output values may 
need to follow a router which uses numeric input and output values. For example, suppose we want 
bus S1::OUT1 to be followed by bus R1::005[1] as  per the following table: 
 

Input switched on bus S1::OUT1 Input switched by TSI1000 on bus 005[1] 
1 001[1] 
2 003[1] 
3 005[1] 
4 007[1] 

 
In this case, the following control string can be used:  
 
on(eq(xpt(S1::OUT1),1,2,3,4),,001[1], 002[1], 003[1], 004[1]) 
 
The numeric input names are used to look up the mnemonic names. Note the two consecutive commas 
just before "001[1]". This would be the input taken if none of the numeric inputs were selected on 
S1::OUT1. Leaving the field empty, as shown here, will cause no switch to occur if an unlisted input 
is selected on S1::OUT1. 

12.2.3 Programming Real Buses Controlled by GPIs 
 
To program a real bus which is controlled by GPIs, follow the procedure in the section on 
"Programming Follower Buses", but use one of the following control strings: 
 

Function Control String 
GPIs 0 to 15 will generate respective takes for 
inputs 001[1] to 016[1]. The "%3" string causes 
3-digit input numbers with leading zeroes to be 
generated. 

sv(*RE,ROC_TAKE)i2n(0,16,%31)[1] 

This simple example allows a GPI input to toggle 
a router bus between router inputs CAM1 and 
CAM2. 

sv(*RE,ROC_TAKE)if(iv(0),CAM1,CAM2) 

 
Note that a common pitfall when programming output controls is to forget to include a router level in 
the input string when router level is part of the bus name. If a level is used in the bus name, then it 
must also be used in the input name generated by control string. Inversely, if a level is not used in the 
bus name then the level must not be included in the generated input name. Also, it is critical that the 
generated input name be correct: if the router being controlled requires leading zeroes, for example, 
then a control string which does not include them will fail. Remember that although some input and 
output names may look like numbe rs, they are really names, and therefore input names "001" and "1" 
are not equivalent ! 

13 Advanced Control String Programming 

13.1  Using Variables 
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Like any programming language, the control strings used to program the Image Video Tally System 
often require the use of variables. A variable is a named storage location which can be programmed to 
remember a value which will be used later. The SV( ) function, as previously mentioned, is used to 
give a variable a value, while the V( ) function is used to read back the variable. The control string 
"sv(VAR,10)v(VAR)" inserted as a display control string will display "10". Note that the SV( ) 
function, unlike most predefined functions, does not produce an output or a display of any sort.  
 
Before we explain how the different classes of variables work, we will first look at how control strings 
are evaluated by the tally display system. Control strings programmed into the TSI1000 are scanned 
and evaluated whenever some external event occurs, such as the change in the state of a GPI input or 
the switching of a crosspoint. For each display or system output device programmed to react to the 
external event, be it a display, a GPI output or a resource output control, it's control string is read and 
processed, and a displayed value is produced, which is sent to the output device. When all output 
devices have been processed, the system waits for the next external event. 
 
During the processing of the control string, variables can be given values and read back. Some 
variables are only needed as temporary storage during the processing phase and can be discarded after 
the system output has been produced, to save internal memory. For example, the result of a complex 
calculation may be needed several times during the control string processing, and is therefore 
calculated once and then stored for repeated use during processing. These variables are called 
"temporary" variables. A side effect of the temporary nature of a temporary variable is that their value 
can be "seen" only by the device fo r which it is programmed. Other devices reading and writing a 
variable of the same name will see only the value of it's own named variable. 
 
Other variables must retain their values between system events, but, like the temporary variables, are 
visible only  within the device for which they are programmed. It is useful to limit the visibility of 
these variables to one device so that the same name can be used for variables belonging to different 
devices, saving the user from having to make up new variable names for every device. 
 
A third class of variable can be used to permanently store values which can be referenced and 
modified by any device control string. at any time These variables are "public" variables. Of course all 
global variables must have unique na mes. 
 
How do we know the difference between the different variable types ? The names of temporary 
variables start with an exclamation mark. The names of private variables start with an asterisk. The 
names of public variables start with a character other than an exclamation mark, an asterisk or a dollar 
sign, which is reserved. 
 

Type  Leading Character Purpose Scope Example 
Temporary  Exclamation (!) To store temporary 

values within a 
single control 
string. 

A stored value is 
retained only within 
a single device and 
the variable is 
deleted after the 
control string is 
processed. 

sv(!X,10)v(!X) 
will display "10" 
but only in one 
device. v(*X) in 
another device 
will not display 
the stored value 
of "10". 

Private Asterisk (*) To store permanent 
values within a 

A stored value is 
retained only within 

sv(*X,10)v(*X) 
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single device. a single device and 
it's value is retained 
until it is modified 
again. 

Public No prefix character To store permanent 
values accessible 
by all devices. 

Any device can 
read or modify the 
value, which is 
retained until it is 
re -modified. 

sv(GLOBAL1,15
)v(GLOBAL1) 

13.2  Using custom functions 
 
Control strings used to program the operation of displays, resource outputs and GPI outputs can 
become quite complex. Often the same logic must be replicated in several, or many, places within a 
configuration. Under these conditions it makes sense to break the task of controlling system outputs 
into smaller pieces and relegate them to a place outside of the programmed device. This is where 
custom functions become useful. 
 
Custom functions are just global variables which contain control strings. However using the V( ) 
function to read such a global variable merely displays the control string itself. In order to evaluate a 
global variable as a control string, it is necessary to pass it to a special function called FN( ).  
 
The procedure for defining a function is as follows: 

 
1. Open the Global Messages dialog box. 
 
2. "Add" a function name such as "GETCOLOR". 
 
3. Type the desired control string into the "Contents" field of the dialog box. For example you might 

have something like "if(pgm(S1::1),ac(85),ac(170))" (which would return either a red colour code 
or a green colour code depending on whether a switcher certain source is onair). 

 
4. Close the dialog box.  
 
5. To use the function in a control string for a display, GPI output or resource output control, type it, 

for example, as fn(GETCOLOR). In this case the contents of GETCOLOR global variable will be 
evaluated. 

 
Now if we were to program something like "fn(GETCOLOR)CAM1" into an Image Video display, 
“CAM1” would be displayed as in red when switcher input 1 goes to air, otherwise it would be 
displayed as green. 
 
Now this function would be much more useful if we could use it more than one place. However, in it’s 
current form, it is only useful if we are interested in what switcher input 1 is doing. What if we want 
the same logic for a number of different inputs on a switcher ?  
 
To do this we can modify GETCOLOR as follows: " if(pgm(v(!S)),ac(85),ac(170))". In this case we 
are reading the input of interest from a temporary variable called "!S" ("S" chosen arbitrarily, standing 
for "source"). In a number of displays we could the program: 



 Page 38   

 
sv(!S,S1::1)fn(GETCOLOR)CAM1 
sv(!S,S1::2)fn(GETCOLOR)CAM2 
sv(!S,S1::3)fn(GETCOLOR)CAM3 
sv(!S,S1::4)fn(GETCOLOR)CAM4 
 
An advantage of this scheme is that if we should ever change our minds about what colour to use, we 
could change it in one place and it would change automatically in all displays. 
 
This is a trivial example, and in fact we would more like ly use the TSS( ) function and a long name 
assigned for each switcher input to do what we have done here. However, it gives an idea as to what 
can be done with custom functions and variables. 
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14 Using the Tally System Console Export / Import functions 

14.1 Rules and Caveats 
 
The import / export function in the Tally System Console is powerful but must be used with care. Note 
the following rules and caveats when using these functions: 
 
1. The spreadsheet file to which you are exporting will not be created by the exp ort function: you 

must create the spreadsheet file before doing the export. This can normally be done by right-
clicking on an open folder and clicking "new" -> "Excel Spreadsheet". 

 
2. All resource interconnections, resource interconnection "ends", displays, resource items, output 

controls, global messages and GPIs are merged into the existing .TSC document by the import 
function. Therefore any of the above types of objects which have been removed or renamed in the 
spreadsheet will still appear in the .TSC document under their original names after the import 
function is used, when you think you may have deleted or renamed them. In the case of a rename, 
both the old object and a renamed new object will appear in the .TSC file. 

 
3. Any changes to the content of interconnections, resource interconnection "ends", displays, 

displays, resource items, output controls, global messages and GPIs will be imported/exported 
properly. For example a change of programming of the contents of a display done in a spreadsheet 
will overwrite the original programmng of a display in the .TSC file when the spreadsheet is 
imported into the .TSC file. As long as only object contents are edited, rather than their names or 
existances, then caveat #2 can be ignored. 

 
4. None of the resource devices (found in the "Name" list of the "Configure Resource Device" dialog 

box) are exported by the Tally System console. This means that importing a spreadsheet into an 
empty .TSC file may result in a .TSC file containing only virtual resource devices with the same 
names as the original resource devices (the resource devices are created because they are 
mentioned in the spreadsheet in various places, but the import function cannot know the type of 
each resource device and so creates them as virtual devices). 

 
5. When adding a line to any page of an exported spreadsheet, attention must be paid to the size of 

the "Named Range" that encompasses each page of spreadsheet data. Only lines and columns 
within each named range will be imported by the Tally System Console. The number of columns 
in each named range is fixed, but the number of rows may expand or contract depending on the 
number of entries on each page. 

 
To set or check the size of a page's named range in Excel, click on "Insert" -> "Name" -> "Define". 
Click on the named range of interest then click on "Refers To". A dotted outline will indicate the 
size of the range. Using Shift-UpArrow/DownArrow allows you to easily change the number of 
rows in the range before clicking on "OK". 

 
Note that using Excel's "Insert  Row" or "Delete Row" column will automatically adust the number 
of rows in the named range. Named range sizes tyically become a problem when information is 
typed or pasted into the empty line after the last used row on the page. Without adjusting the 



 Page 40   

named range, such a line or lines will be ignored by the import function. Make a practice of 
checking the size of each named range before exiting and importing your spreadsheet. 
 

6. When creating a configuration from scratch using a spreadsheet, first make a dummy .TSC file 
containing one of each of a resource interconnection, a display, a resource item, an output control, 
a global messages and a GPI output, then export the .TSC file to a spreadsheet. This will create 
one of every possible type of data page in the spreadsheet, and give you some examples to work 
from. 

 
7. Strings longer that 256 characters in any field will be truncated to 256 characters. 

14.2  A Fairly bullet-proof procedure for export / import  
 
1. When creating your configuration for the first time in the Tally System Console, first enter the 

resource devices, including interface numbers, comm ports, and types, then, before entering any 
other configuration data , save the file as "BASE.TSC". This will be your import base file, 
containing all of the resource devices which will not be exported by the Tally System Console. 

 
2. On the other hand, if you have already created your complete configuration and wish to do an 

export / import, make a base file by deleting all resource interconnections, displays, resource 
items, output controls, global messages and GPIs, then save it out as your base file. Use the 
keyboard shortcuts to do the removals, which will be much quicker than using the mouse. These 
resources can be located as follows: 

 
Resource Interconnections: Ctrl-Shift-F9, click on "Remove" or enter "Alt -V" until all entries are 
removed. 
 
Displays: Ctrl-F10, click on "Remove" or enter "Alt-V" until all entries are removed. 
 
Resource Items : Ctrl-F9, click on "Remove Item" or enter "Alt-I" until all entries are removed. 
 
Output Controls : Ctrl-F9, click on "Output Controls", click on the first "Output" for each 
"Resource" and "Remove" all outputs (click "Remove" or enter "Alt -V" until all entries are 
removed. 
 
Global Messages: Ctrl_Shift-F8, click on "Remove" or enter " Alt -V" until all entries are removed. 
 
GPIs: Ctrl-Shift-F10, click on "Remove" or enter "Alt-V" until all entries are removed. 

 
3. Export your configuration .TSC file to an newly-created empty spreadsheet, make your changes to 

the spreadsheet, then open the BASE.TSC file using the Tally System Console, and import the 
modified spreadsheet into it. Then save out the Tally System console as a file other than 
BASE.TSC, overwriting the original .TSC file if you wish. 

 
This procedure will ensure that changes made to remove or rename objects in the Tally System 
Console are saved accurately. 
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14.3  Other possible pitfalls in export / import  
 
1. The information in certain columns will be restricted to certain keywords. For columns other than 

the ones you are interested in changing, copy information from other rows, rather than filling in the 
information yourself. In situation where you wish to change a keyword, export an example of what 
you want from the TSC to obtain the correct keyword. 

 
2. Look out for situations such as duplicate object names. For example, there should never be two 

resource interconnections entries with the same name. 
 
3. The first two colums in the "DisplayUnit" and "DisplaySection" pages must contain identical 

names and serial numbers. Note that for dual or triple displays, the "DisplayUnit" page will 
contain one entry for each display, while the "DisplaySection" page will contain multiple entries, 
one for each section, but with identical names and serial numbers. 

 
4. When creating new displays in the spreadsheet, and if you are interested in using the display layout 

pages (F3 in the Tally System Console), you should take care of the entries in the "LayoutH" and 
"LayoutV" columns, which lays out the coordinates for each display in the layout pages. Often it is 
easie r to create the new displays in the Tally System Console, especially if you have a consecutive 
set of serial numbers to work with, than do it in the spreadsheet, since the TSC will auto-fill the 
serial numbers and names for you. You can easily rename the displays to your liking in the 
spreadsheet. Be sure to use the CTRL -W function in the Tally System Console to make your dual 
or triple displays before exporting your starting configuration. 

 
In general, be careful of information you enter in the spreadsheet, keeping in mind that the Tally 
System Console does a lot of checking not done by the spreadsheet. For the more repetitive steps of 
simply adding objects to the configuration, it is often easier to add all of the required objects in the 
Tally System Console, then edit their contents in the spreadsheet, allowing the advantages of safe 
creation of information enjoyed in the Tally System Console along with the easy editing of data 
provided by spreadsheet programs. 
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Appendix A - GPI Address Chart 
The following chart is useful for calculating values used in the GPI outputs dialog box, and in the IV( ) function.  
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1  1 0 5 1 32 9 1  64 13 1  96 
1  2 1 5 2 33 9 2  65 13 2  97 
1  3 2 5 3 34 9 3  66 13 3  98 
1  4 3 5 4 35 9 4  67 13 4  99 
1  5 4 5 5 36 9 5  68 13 5  100 
1  6 5 5 6 37 9 6  69 13 6  101 
1  7 6 5 7 38 9 7  70 13 7  102 
1  8 7 5 8 39 9 8  71 13 8  103 
2  1 8 6 1 40 10 1  72 14 1  104 
2  2 9 6 2 41 10 2  73 14 2  105 
2  3 10 6 3 42 10 3  74 14 3  106 
2  4 11 6 4 43 10 4  75 14 4  107 
2  5 12 6 5 44 10 5  76 14 5  108 
2  6 13 6 6 45 10 6  77 14 6  109 
2  7 14 6 7 46 10 7  78 14 7  110 
2  8 15 6 8 47 10 8  79 14 8  111 
3  1 16 7 1 48 11 1  80 15 1  112 
3  2 17 7 2 49 11 2  81 15 2  113 
3  3 18 7 3 50 11 3  82 15 3  114 
3  4 19 7 4 51 11 4  83 15 4  115 
3  5 20 7 5 52 11 5  84 15 5  116 
3  6 21 7 6 53 11 6  85 15 6  117 
3  7 22 7 7 54 11 7  86 15 7  118 
3  8 23 7 8 55 11 8  87 15 8  119 
4  1 24 8 1 56 12 1  88 16 1  120 
4  2 25 8 2 57 12 2  89 16 2  121 
4  3 26 8 3 58 12 3  90 16 3  122 
4  4 27 8 4 59 12 4  91 16 4  123 
4  5 28 8 5 60 12 5  92 16 5  124 
4  6 29 8 6 61 12 6  93 16 6  125 
4  7 30 8 7 62 12 7  94 16 7  126 
4  8 31 8 8 63 12 8  95 16 8  127 

To use the chart, find the system-wide I/O connector number, starting from the first connector on the 4211 unit with the 
lowest DIP switch setting. Subsequent connector numbers are in order of DIP switch setting and I/O connector number. 
Then determine a channel number from 1-8 within the connector, in order of pin numbering. Use these two values to look 
up the GPI input or output address. 
 
For example, to find the address of the fourth channel in the third connector on the second GPI unit (determined as the unit 
with the second-highest DIP switch setting), where each GPI unit has five connectors: 
 
• The system-wide connector number will be 5 + 3 = 8.  
• The channel number within the connector will be 4. 
• The address looked up will be 59.  
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Appendix B – Setting The Number of RDU1500/1600 Display 
Sections 

 
To set a display for Single, Dual or Triple mode: 
 
1. Put the Tally System Console online with the TSI1000. Your PC must be within sight of the 

display your are setting. 
2. Press F6 and select the display you wish to change.  
3. Press CTRL-F3. 
4. If a menu does not appear on the display, follow the procedure below for enabling the display 

menus. 
5. Press “2” (“setup”) and 2 (“width”). 
6. Press “1” until you get a either (1) a display with all ones (2) a display with ones on the left and 

twos on the right or (3) a display with ones on the left, twos in middle and threes on the right, 
corresponding to a Single, Dual or Triple type. Continuing to press “1” will cause the display to 
cycle through the three types. 

7. Press “7” (“Done”). 
8. Note that you can confirm the type of display (single, double, triple) by pressing 2 (“Select”). You 

may then press 7 to get the “>Setup” menu back or simply wait for 5 seconds for the menu to 
return by itself. 

9. In the “>Setup” menu, press 1 (“ID”). 
10. Press 1 (“ID1”) and enter three zeroes to clear the ID value to zero. Press Enter. 
11. Press 2 (“ID2”) and enter three zeroes to clear the ID value to zero. Press Enter. 
12. Press 3 (“ID3”) and enter three zeroes to clear the ID value to zero. Press Enter. 
13. Press ESC to return to “>Setup”. 
14. Press “8” (“Save ?”) and respond with “Y” to the prompt. 
15. Press CTRL-F3 to exit the menus. 
16. If you had to enable the menus, disable them again as described below. 
 
Enabling and disabling display menus 
 
1. Get the serial number of the display. 
2. If you have already pressed CTRL-F3 once in an attempt to enable the menus, press it again to exit 

the menu mode. 
3. Press CTRL-F3. 
4. Enter the following string: %5UXXXXX%15N% -15N%254W%-254W, replacing the XXXXX 

with your serial number. The “5” in %5U is equal to the length of the serial number. 
5. To check whether the menu is now enabled, enter %2x to enter the menu and ESC to get back out. 
6. Press CTRL-F3 to exit menu mode. 
7. To disable the menus follow the above procedure, but enter %5UXXXXX%14N%-14N%254W%-

254W, where XXXXX is again a display serial number. 
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Appendix C – Setting The TSI1000 IP Address 
 

1. Connect a keyboard and a VGA monitor to the TSI1000. 
 
2. With the TSI1000 running normally, enter the keysequence ALT-1-2-3 (hold down the ALT 

key while pressing key “1” then “2” then “3”. 
 

3. Wait for the TSI1000 to reboot to the DOS prompt. 
 

4. Enter “setup” (not including quotes) followed by a space character, followed by an IP address 
in number-dot format (for example 192.168.1.1), then press ENTER. For example, the set the 
IP address 192.168.1.1, type “setup 192.168.1.1” and ENTER. 

 
5. Some information will scroll by on the VGA monitor, then six pages, each followed by a 

prompt to “Press any key”, will be presented. Pressing ENTER three times will display a page 
showing the new IP address. Continue to press ENTER until the DOS prompt is displayed. 

 
6. Type the word “BOOT” (not including quotes) followed by the ENTER key to restart the 

TSI1000. 
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Appendix D – Setting The TSI1000 Interface Number 
 
Each TSI1000 has an “interface number” between 1 and 16 stored on it’s flash disk. Because it is 
possible for a number of TSI1000s to be networked together, either for redundancy or to increase the 
number of available serial interface ports, it is necessary to assign each routing, switching and display 
device to a particular TSI1000 for connection purposes. 
 
The interface number is used when configuring a TSI1000 tally system to denote the TSI1000 to 
which a particular device will be connected. For example, when configuring an Image Video 
RDU1510 under-monitor display, both a serial port number and an interface number is required to be 
specified. This is also true of all routing and switching devices, as well as GPI outputs. 
 
TSI1000s are normally programmed from the factory with an interface number of 2, and this is the 
default value set when a new device is programmed. The interface number of a TSI1000 is required to 
be changed only when more than one or more TSI1000s are networked for the purpose of extending 
the number of available serial ports. Two TSI1000s networked for the purpose of redundancy will 
have the same interface number and each of those units may be left with a interface number of “2”. 
 
To change the interface number of a TSI1000: 
 
1. With the TSI1000 online and with it’s COM1 port directly connected to the Tally System Console 

PC, open the “Configure System Interface” dialog box. There should be at least one TSI1000 
interface number and IP address listed under “Interface”. 

 
2. Click on the TSI1000 which needs the interface number changed. 
 
3. Click on “Change”. A “Change System Interface” dialog box will pop up. 
 
4. Change the value of “New Number” to the required interface number. 
 
5. Close the pop-up dialog box and the “Configure System Interface” dialog box. 
 
6. The TSI1000 will reboot and have the new interface number when it comes back online. 
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Appendix E –TSISETUP: The TSI1000 Maintenance Utility  

1. Overview 
 

TSIsetup is a program available in TSI1000 version 1.82 and higher and is used to administer the 
TSI1000 flash disk. The program is operated via the TSI1000’s COM1 port (same port as used for the 
Tally System Console). Files can be transferred to and from the TSI1000’s flash disk using a PC 
equipped with a serial port and a standard serial communications program such as Hyperterm. Note 
that the communications program must support the ZMODEM file transfer protocol. 
 
The TSIsetup program can be invoked either while the TSI1000 is running or from DOS. The former 
method requires only  a serial connection to COM1, the Tally System Console port. The latter method 
requires that a VGA monitor and keyboard be connected to the TSI100. 
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2.  Invoking TSIsetup  

2.1 Invoking TSIsetup from Hyperterm 
 
This method of invoking Hyperterm works while the TSI1000 is in operation. If the TSI1000 is very 
busy, this can lead to communications errors when transferring files on and off the TSI1000, in which 
case it may be preferable to invoke TSIsetup directly as described in section 2.2. 
 
To invoke TSIsetup while the TSI1000 is running: 
 
1. Exit the Tally System Console Program. 
 
2. Start Hyperterm and set the following properties: 
 

• 115200 baud, 8 data bits, no parity, 1 stop bit. 
• Direct to COM1 or COM2. 
• Zmodem file transfer protocol. 
• Save the setup. 

 
3. When Hyperterm first starts the TSI1000 could still be transmitting in an attempt to contact the 

Tally System console. This will appear as garbage in Hyperterm because of the differing baud 
rates. Wait for the transmissions to cease, which should occur within approximately ten seconds. 

 
4. Three or more seconds after exiting the Tally System Console, Press CTRL-BREAK. Wait for the 

prompt which asks for the entry of three plus sign characters (+++). The characters must be 
entered within three seconds, or CTRL-BREAK must be pressed again.  

 
5. Enter SETUP and ENTER. The TSI1000 will shut down and the TSIsetup prompt will appear. 



 Page 48   

2.2 Invoking TSIsetup From the TSI1000 keyboard 
 
To invoke TSISETUP from a keyboard connected directly to the TSI1000, so that file transfers can 
occur without the TSI1000 firmware running: 
 
1. Start Hyperterm and set the following properties: 
 

• 115200 baud, 8 data bits, no parity, 1 stop bit. 
• Direct to COM1 or COM2. 
• Zmodem file transfer protocol. 
• Save the setup. 

 
2. Boot the TSI1000 into DOS by entering the ALT-1-2-3 key sequence at the TSI keyboard. 
Alternately, the TSI1000 can be powered down and back up, and the CTRL-BREAK key repeatedly 
pressed during boot-up to interrupt the execution of AUOTEXEC.BAT and get the DOS prompt.  
 
3. Type “DOSBOOT TSISETUP.BIN” to start TSISETUP. The TSIsetup prompt will appear. 
 
4. In Hyperterm, press CTRL-BREAK. Wait for the prompt which asks for the entry of three plus 
sign characters (+++). The characters must be entered within three seconds, or CTRL-BREAK must 
be pressed again. TSIsetup is now ready to use. 
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3. TSIsetup commands 
 
The available TSIsetup commands are as follows: 
 

• RZ: Receive a file using the Zmodem protocol. 
• SZ: Send a file using the Zmodem protocol. 
• DIR: list files, similar to DOS DIR command. 
• DEL: delete a file. 
• REN: rename a file. 
• CRC: get a file CRC, to confirm file integrity. 
• EXIT: boot into DOS. 
• TSI1000: Start the TSI1000. 
• REBOOT: restart the TSI1000 and reenter TSIsetup. 
 

3.1 RZ: Receive a file using the Zmodem protocol. 
 
Syntax: RZ <ENTER> 
 
RZ is entered followed by ENTER to start TSIsetup waiting for a Zmodem file transfer to start. Once 
RZ has been entered, select the Zmodem file send command, select the file to be sent, then start the 
transfer. Wildcards can be used in Hyperterm to send multiple files in one transfer session. 

3.2 SZ: Send a file using the Zmodem protocol. 
 
Syntax: SZ <filename1> <Filename1> …<ENTER> 
 
Start the Zmodem receive task in the communications program then enter SZ with a list of filenames 
followed by ENTER. Hyperterm starts the Zmodem receive task automatically upon receiving the 
Zmodem file transfer request, so if Hyperterm is used, entry of the SZ command is all that is required 
to start a file transfer. 

3.3 DIR: list files. 
 
Syntax: DIR <filespec> <ENTER> 
 
Th normal DOS (*, ?) wildcards are allowed. The names of files on the flash dish along with their 
sizes are listed, and the total number of bytes in the listed files is also displayed. 

3.4 DEL: delete a file. 
 
Syntax: DEL <filespec> <ENTER> 
 
Th normal DOS (*, ?) wildcards are allowed. Files necessary for the communicating with the TSI1000 
or necessary for it basic operation cannot be deleted. 
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3.4 REN: rename a file. 
 
Syntax: REN <old filename> <new filename> <ENTER> 
 
The given file is renamed. 

3.6 CRC: get a file CRC, to confirm file integrity. 
 
Syntax: CRC <filespec> <ENTER> 
 
Th normal DOS (*, ?) wildcards are allowed. The names of files on the flash dish along with their 
CRCs and sizes are listed. The file CRC is useful for checking the integrity of the files on the disk. A 
utility is available for checking the CRCs of the original files for comparison purposes, and files 
released by Image Video for transfer to the TSI1000 are documented with their CRC values for 
comparison. 

3.7 EXIT: boot into DOS. 
 
Syntax: EXIT <ENTER> 
 
The TSI1000 well reboot and restart in DOS. 

3.8 TSI1000: Start the Tally System Controller. 
 
Syntax: TSI1000<ENTER> 
 
The TSI1000 will begin to operate its prime function as a tally system controller. 

3.9 REBOOT: restart the TSI1000 and reenter TSIsetup. 
 
Syntax: REBOOT<ENTER> 
 
The TSI1000 will reboot and restart TSIsetup. 
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Appendix F – Upgrading the TSI1000 software  
 
There are several means available for upgrading the TSI1000 software. The usual method is via FTP, 
described in section 4 of this appendix called “Upgrading TSI1000 software using FTP”. 
 
Note: When upgrading TSI11000 software installed before or during July 2003 with software released 
after that time, it may be necessary to reload your system configuration from the Tally System 
Console due to changes in the flash-disk file format. After the new software is loaded, see section 7 on 
“After You Upgrade” at the end of this appendix to complete the upgrade process. 

1. Upgrading TSI1000 software using the Tally System Console program 
 
1. Have a PC running the Image Video Tally System Console program running and in 

communication with the TSI1000. 
 
2. Exit the Tally System Console program. 
 
3. Follow the instructions provided by Image Video to extract a file called TSI1000B.EXE from the 

release media (disk, email, etc.). 
 
4. Right-click on the console program icon on your desktop, select "Properties" then the "shortcut" 

tab at the top of the dialog box. Click on the "Find Target" button. A window will pop up, 
containing TSCONS.EXE. 

 
5. Copy TSI1000B.EXE to the folder containing TSCONS.EXE.  
 
6. Turn off the TSI1000 for about five seconds and turn it back. Wait until the normal running LEDs 

have come back to normal and the CPU LED has stopped flashing. 
 
7. Start the Image Video Tally System Console program. A prompt asking whether you wish to 

upgrade the TSI1000 software will be presented. Click on "Yes". A progress box will open up. The 
transfer will take about  fifteen minutes. 

 
8. Once the upgrade has completed, exit the console program and reboot the TSI1000. The new 

software will now be running. 
 
9. IMPORTANT: delete the TSI1000B.exe file from the TSCONS folder. (Otherwise the software 

upgrade prompt will occur whenever the console program is restarted). 
 
10. Res tart the console program. 
 
11. See the section below on “ After You Upgrade” below on any further actions you may need to take 

to complete the software upgrade process. 

2. Upgrading TSI1000 software using Windows “HyperTerminal” 
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This software upgrade option is available only on TSI1000 versions 1.82 or later. 
 
1. Follow the instructions provided by Image Video to extract a file called TSI1000B.EXE from the 

release media (disk, email, etc.).  
 
2. Start Hyperterm. If the Hyperterm starts up “connected”, click on “Call” and “Disconnect”. 
 
3. Click on File  > Properties and in “Connect Using” select “Direct to COM1” or “Direct to COM2” 

(depending on which port your PC is using to talk to the TSI1000. 
 
4. Click on “Configure” and set communications parameters 115200 Baud, 8 data bits, no stop bits. 

Click on “OK”. 
 
5. Click on “Call” to connect to the TSI1000. If any garbage characters are received, wait until they 

cease. 
 
6. Three or more seconds after exiting the Tally System Console, press CTRL-BREAK. Wait for the 

prompt which asks for the entry of three plus sign characters (+++). The characters must be 
entered within three seconds, or CTRL-BREAK must be pressed again. The TSI1000 will respond 
with “Zmodem installed”.  

 
7. Type “sz TSI1000B.EXE” (no including quotes) and press enter. The TSI1000 will respond with 

“Zmodem transmitter starting” and Hyperterm will automatically receive the TSI1000B.EXE file 
from the TSI1000, usually placing it in the "Hyperterm" directory. When done, after about four 
minutes, the TSI1000 will transmit the "Zmodem transmitter done" prompt. (This step is advisable 
in order to keep a copy of the currently operational software, just in case it is necessary to return to 
that software version. Confirm that the file has been received before contin uing.) 

 
8. Type “rz” (no including quotes) and press enter. The TSI1000 will respond with “Zmodem 

receiver starting”. 
 
9. Click on “Transfer” and “Send File”. Under “Filename” enter the path and file name for your copy 

of the upgrade TSI1000B.EXE file. You may a lso use the “Browse” function to locate the file. 
 
10. Click on “Send” to start the file transfer, which should take about 4 minutes. When the transfer is 

done, the HyperTerminal file transfer dialog box will disappear and the TSI1000 will respond with 
“Zmodem receiver done”. 

 
11. Power off the TSI1000 for five seconds then turn it back on. The new software will begin running. 
 
12. See the section below on “ After You Upgrade” below on any further actions you may need to take 

to complete the software upgrade process. 
 
NOTE: if there are communications errors using this method, instead of step 6 a more direct method of 
invoking the Zmodem transmitter on the TSI1000 can be used, using a keyboard and monitor 
connected to the back of the TSI1000 can be used. This method is described in Appendix E Section 
2.2. 
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3. Upgrading TSI1000 software using Laplink 3 
 
1. Follow the instructions provided by Image Video to extract a file called TSI1000B.EXE from the 

release media (disk, email, etc.).  
 
2. Attach a keyboard and monitor to the TSI1000, which must be running. Hold down the ALT key 

and quickly the enter three-key sequence 1-2-3. This should reboot the TSI1000 into DOS. (See 
note 1).  

 
3. Connect a parallel Laplink cable between the TSI1000 and a Windows computer containing the 

TSI1000 software. You can also use the serial port for a Laplink transfer. (See note 2)  
 
4. Type LL3 at the TSI1000 keyboard to start LAPLINK. 
 
5. Run Laplink on the PC. You may have to restart the computer in DOS mode (using F8 during the 

Windows startup and selecting "Command only" mode) in order to run LAPLINK. 
 
6. Use the left/right keys to select PC directory (one Laplink pane will contain the PC directory and 

the other the TSI1000 directory). 
 
7. Use the up/down arrow keys to select the TSI1000B.EXE file on the PC. To change directories, 

use the “L” (Log) command. 
 
8. Use the “C” (Copy) command to transfer the TSI1000B.EXE file to the TSI1000. 
 
13. Power off the TSI1000 for five seconds then turn it back on. The new software will begin running. 
 
14. See the section below on “ After You Upgrade” below on any further actions you may need to take 

to complete the software upgrade process. 
 
NOTE 1: Older software versions may not support this feature, so if the TSI1000 does not reboot as a 
result of the Alt-1-2-3 sequence, cycle the power on the TSI1000 and press CTRL-BREAK while  
rebooting in order to break out of the AUTOEXEC.BAT startup. 
 
NOTE 2: LL3 serial mode: 
1. Press "O" for "Options". 
2. Use down -arrow to get to "Transfer Mode". 
3. Use left-a rrow to select "serial". 
4. Use down -arrow to get to "Port". 
5. Use left-right arrow to select the port (See note 3) 
6. Press "S" and ENTER to save the new options. 
7. Press ESC to leave "Options". 
 
NOTE3: COM1 and COM2 markings on the TSI1000 are opposite the COM1 and COM2 denoted in 
Laplink: if connected to the TSI1000 COM1, select COM2 in Laplink, and vice versa. 
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4. Upgrading TSI1000 software using FTP 
 
Before beginning: If the network port of the TSI1000 is not used in your system then the factory 
setting of the TSI1000 is probably 192.168.0.202. If you are using the network port but do not know 
the IP address of the TSI1000, check the section below on "Finding the TSI1000's IP address". 
 
1. Make a physical network connection between your TSI and the PC (using a crossover network 

cable or a hub). 
 
2. Set your PC to be in the same subnet mask as the TSI1000 (the TSI's subnet mask is factory -set to 

255.255.255.0 so your PC must have the same first three octets in it's IP address. e.g. if the 
TSI1000 has an IP address of 192.168.0.202 then your PC must be something like 192.168.0.210). 
On  a Windows PC this means setting the "IP Address" option of your TCPIP network adapter to 
"Specify an IP Address" with an address, instead of  "Obtain a network address automatically". 

 
3. Ping the IP address of the TSI1000 to make sure it is there. 
 
4. If you are running a version of Windows later than Win98, start an internet browser on the PC 

connected to the TSI1000 and in the “Address” bar enter the “ftp://” then the TSI's IP address: for 
example, ftp://192.168.0.202 . If you are running an older version of Windows, use a FTP client 
such as WS_FTP. Some earlier Windows browsers did not allow ftp transfers to the remote client. 

 
5. If you wish to first download the old version of TSI1000B.EXE, and you are using a browser, drag 

the TSI1000B.EXE file from the client area of the browser to some location other than where the 
new TSI1000B.EXE file is stored. If you are using an FTP client, point the local d irectory window 
to some location other than where the new TSI1000B.EXE file is stored, click on TSI1000B.EXE 
in the remote window, then click on the transfer button to get the file from the TSI1000. 

 
6. To upload the new software to the TSI1000, if using a browser, drag the TSI1000B.EXE file to the 

client area of the browser to send the file to the TSI1000. If using an FTP client, point the local 
directory window to the location of TSI1000B.EXE, click on the file, then click on the transfer 
button to send the file to the TSI1000. 

 
7. To use the command-line FTP available in most versions of Windows, see the section below. 
 
8. See the section below on “ After You Upgrade” below on any further actions you may need to take 

to complete the software upgrade process. 

5. Upgrading TSI1000 software using Command-line FTP 
 
1. Follow steps 1-3 in “ Upgrading TSI1000 software using FTP”. Your new TSI1000B.EXE file 

should be stored to a directory other than the current one. 
 
2. Click on the Windows “Start” button, click on “Run” and type “FTP”Open a DOS or command-

line window window. 
 

Field Code Changed
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3. Type "FTP" followed a space and the IP address of the TSI1000 and press <Enter> (e.g. FTP 
192.168.0.202<Enter>. 

 
4. At the "User" prompt hit Enter, and do the same at the "Password" prompt. 
 
5. Type "Binary"<Enter> 
 
6. If you wish to first download the old version of TSI1000B.EXE, type “Get TSI1000B.EXE”. 
 
7. Assuming that “TSI1000B.EXE” is stored at C:\TEMP, type "Send 

C:\TEMP\TSI1000B.EXE"<Enter> and wait for the file to be sent. 
 
Type "Bye"<Enter>  
 
9. See the section below on “ After You Upgrade” on any further actions you may need to take to 

complete the software upgrade process. 
 
To simplify the FTP process, the following 5 lines can be pasted into a batch file (e.g. FTPIT.BAT). 
This can be done by opening NOTEPAD, pasting and modifying the IP address to the IP address of 
your TSI1000, then click on “File” and “Save As” to create your batch file. To run the batch file and 
send the TSI1000B.EXE file to the TSI1000, use Windows Explorer to open the folder containing the 
batch file and double click on the batch file. 
 
echo open 192.168.0.227>ftp.cmd 
echo binary>>ftp.cmd 
echo send c:\temp\TSI1000B.EXE>>ftp.cmd 
echo bye>>ftp.cmd 
ftp -A -s:ftp.cmd  

6. Finding the TSI1000's IP address 
 
Method 1: Get the FTP address from a label on the back or side of the unit. If the IP address has been 
changed since the TSI1000 was shipped from the factory, the label may be out of date. 
 
Method 2:  Connecting a VGA monitor and keyboard to t he back of the TSI1000.  Press CTRL-PGDN 
until you get to a screen that says "tsinet events" in the top left corner of the screen. PGDN once to get 
to "Page 2 of 3". The IP address is on the second line of text on the left (probably pre -pended with  
"01:" or some other number followed by a colon, which can be ignored). 
 
Method 3: In TSI1000s released after June of 2003, with the Tally System Console online with the 
TSI1000, create a test UMD display (call it TEST-UMD, do not use the same name as a GPI output). 
Enter the text “v(_READVAR_TSIADDRESS) into the text area of the display. The display will show 
the TSI’s interface (ID) number followed by a colon, followed by the IP address.  
 

7. After You Upgrade 
 
When upgrading TSI11000 software installed before or during July 2003 with software released after 
that time, it may be necessary to reload your system configuration from the Tally System Console due 
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to changes in the flash-disk file format: 
 
1. Update your system software as per the instructions in this appendix (above). Whichever method 

you have chosen to upgrade the software will specify that the TSI1000 to be rebooted to invoke the 
new software. 

 
2. When the new software is running, it will check the flash disk format and will remove any files 

which are out of date from the TSI1000 flash disk. This has no effect on the configuration stored 
on the configuration PC which runs the Tally System Console.  

 
3. If out of date files are removed from the flash disk, the TSI1000’s “CPU” LED will go to a 

flashing amber state. If the CPU LED remains green after the reboot, no further action is required. 
 
4. If the CPU LED is in the flashing amber state, put Tally System Console online with your TSI1000 

as you usually would, allowing it to load the configuration, then reboot the TSI1000. The TSI1000 
will come back with a green CPU LED. 

 
5. If you need to revert to your old software (and have first downloaded a copy of the TSI1000B.EXE 

file), delete the configuration files from the flash disk by attaching a keyboard to the lower PS2 
port on the back of the TSI1000, hold down the “ALT” key and quickly enter the key sequence 
“1,2,C” (no quotes or commas). The TSI1000 will reboot and come back with only the CPU and 
COM1 LEDs on, and possibly the ENET LED. Then reload your old TSI1000B.EXE file and 
reload your system configuration from the Tally System Console. 
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Appendix G – Device-specific setup tips  

1. Philips Saturn Switcher Setup 
 
To set up the Philips end of an interface between the Image Video Tally Display System and a Philips 
Saturn Mas ter Control Switcher, open the Philips Jupiter Configuration Editor, select “Configure” and  
“MPK Devices”. Go to “Edit” and “Add” one line to the device list for each Saturn switcher, as per 
the following: 
 
Devname: an arbitrary unique name suggestive of the Saturn/Image Video tally system interface (e.g.  
IMGTLY or SW1TLY). 
 
Devtype: Select MI3040IO. 
 
Exp: Select “No”  
 
Board: The name given to the switcher frame hardware given in the “Network Description” section of 
the Jupiter Configuration Editor. 
 
Address: A arbitrary unique hexadecimal MPK address which will match the “Device Address” 
entered for the Saturn switcher in Video Tally Display Console program. 
 
When the MPK port is set up, close the MPK device editor, then go to “Configure”, “Switcher output” 
and select the Venus router. Fill in “Outname” with a router destination name (usually called MAINA 
and MAINB) for each of the “A” and “B” inputs to the switcher. Also fill in a physical output number 
under the appropriate level (usually SDV). The other columns are left blank.  
 
Compile and load the configuration into the Jupiter system. See the Philips manual for further details 
on loading Jupiter configurations. 
 
The TSI1000 will be connected to the MPK bus which interconnects the Philips video processor frame 
with the Philips master control panel.  
 
To set up the TSI1000 to interface with the Saturn switcher: 
 
1. Start the Tally System Console program online with the TSI1000,  
 
2. Open the “Configure Resource Devices” dialog box. 
 
3. Enter a name for the Saturn switcher under “Name” (e.g. “S1”) and click “Add”. 
 
4. Click on  “Port” and select “BTS Saturn Master Swr. MPK (COM port)” in the “type” dialog box. 
 
5. Set “Interface” to match the interface number of the TSI1000 (usually 2). 
 
6. Set the port to which the Saturn switcher will be connected. 
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7. Set the “Device Address” to the hexadecimal MPK address entered into the Jupiter configuration 

editor.  
 
8. “Format” can probably be ignored, as current versions of the TSI1000 have a fixed setting of 

38400 baud, 8 data bit, even parity, 1 stop bit, which is the default setting for the Philips MPK 
port.  

 
9. Repeat steps 3 to 6 to set up a BCS3000/Jupiter/Venus router, which will be required to tally the 

“MAIN-A” and “MAIN-B” buses serving as external Program/Preset buses for the Saturn  
switcher. 

 
10. In the “Resource Interconnections” dialog box, setup up interconnections to switcher inputs “A” 

and “B” from the “MAIN -A” and “MAIN -B” router buses. The physical numbers for these can be 
found in the Jupiter control panel sets used for the Image Video tally system interface to the 
BCS3000/Venus/Jupiter router. For example, if the switcher is called S1 and the router is called 
R1, and the MAINA/B router buses are 000 and 001 on the first level, then setup interconnections 
which could be called MAINA and MAINB, with origins of R1::000[1] and R1::001[1] and ends 
of S1::A and S1::B respectively. 

2. Sony MVS8000 Setup 
 
1. Go to "Engineering Setup" (button on MVS8000 console control panel). 

 
2. Go to Switcher -> Output and find the physical output to which "P/P PGM" is assigned. Also find 

"P/P Pvw"'s output if you need Preview tally. The number and name of each bus is in the list 
headed "Out#/Output". Take note of these output numbers for to use in the next step. 

 
3. Go to Router/Tally -> Tally Enable and assign each of the outputs found for the P/P buses (in step 

2) to one of tallies R1,R2,R3,R4 or G1,G2,G3,G4. The four "Red" tallies and the four "Green" 
tallies in Sony switcher correspond to switcher buses GP1RED, GP2RED, GP3RED, GP4RED, 
and GP1GRN, GP2GRN, GP3GRN, GP4GRN in the Image Video switcher configuration. 

 
4. Usually Program is assigned to R1 (Red 1) and Preview is assigned to G1 (Green 1). To do this 

assignment, for each output, use "New" or "Modify" to put the required output numbers into the 
tally output list (if they are not already there). 

 
5. For each output in the tally output list use the "Enable No." button on the right to assign the tally 

type for each output in the list. The tally types are entered as numbers 1 to 8 into the Enable 
keypad as follows: R1=1, G1=2, R2=3, G2=4, etc. 

 
6. Go to Router/Tally -> Serial Tally. Set the tally types which will be used on the serial port. 

Usually at least R1 and possibly G1 are required. The port to be selected in this menu will be one 
of DCU1 port 1 or 2, DCU2 port 1 or 2 or Editor Panel port, depending on the Sony switcher port 
that the TSI1000 will be connected to.  

 
7. Go to Router/Tally -> Router and select "Device" SWR1 or SWR2 (usually SWR1). Select each of 

Source, Destination and Level keys down the right side of the page and set each to "1" to map the 
switcher I/O.  
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8. The RS422 cable to the TSI1000 must cross the Receive and Transmit lines. 

3. Pesa Router setup 
 
1. The Pesa Router must use COM2 on the TSI1000 and must be set up as an RS-232 connection, 

with wiring in place to support RTS/CTS handshaking. 
 
2. The Pesa router interface is a numeric interface using 3-digit values with leading zeroes for all 

input and output numbers. The first input and the first output are numbered “001”. Levels are 
designated with non-leading-zero numbers starting from 1 enclosed in square brackets at the end of 
the input/output number (e.g. 001[1] is a valid Pesa I/O number). 

 
3. Note that the I/O numbers are not physical numbers corresponding to the router wiring, but logical 

numbers taken from the Pesa configuration GUI. To get a list of the numbers, go to the Pesa GUI 
and navigate to Configuration > Source or Configuration > Destination. Click on “View by 
Number” and use the numbers in the left column of the listing to set up the TSI1000 configuration 
for the Pesa router. 

 
1. Use COM1 or COM2 on the Pesa router.  

4. Ensemble Avenue 5250 SDI-to-Analog-Video Converter Interface 
 
The Ensemble Avenue 5250 provides a video output containing a text field which can be programmed 
via an RS422 serial port. The 5250 is treated as a UMD by the Image Video TSI1000. 
 
Although there can be a number of Avenue chassis containing 5250 D/A cards, the serial connection 
from the TSI1000 to the Avenue system is made to a single chassis. The Avenue system is responsible 
for distributing the serial data to the other chassis, each of which has an individual serial address.  
 
Each Avenue chassis contains up to 10 5250 slots. Each 5250 card contains 5 D/A channels. 
 
In order to program a 5250 display, use the Tally System Console program to create a UMD display 
on the TSI1000 serial port which will be connected to Avenue system. To create the display, enter 
CTL-F10 to invoke the “Configure Display Units” dialog box. Set the display type as “8-color display 
(Ensemble Avenue 5250)”, and click on “Port” to set the TSI1000 serial port to be used for the 
display. 
 
The name of the display has a specific format which specifies the address of the corresponding display 
hardware within the Avenue system. The format is: 
 
<Chassis Address><Separator><Module (slot) address><Separator> <Channel address> 
 
Each address is a decimal numeric value. The separators are non-decimal strings, usually a single slash 
or some other punctuation character. Chassis address values range from 1 to 100. Module address 
values range from 1 to 10. Channel address values range from 1 to 5. The chassis address is set up 
using a programming switch and display built into each Avenue chassis.  
 
Example: Display “3/8/4” is the 5250 display at chassis 3, slot 8 channel 4. 
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To program the contents of the text display, enter a text string into the UMD represented in the Tally 
System Console as would be done for an Image Video UMD. The text will be displayed in the 5250 
channel in white characters. 
 
Text colours and tally blocks may be controlled by using the display extension (“*DE”) variable at  
the beginning of the UMD text edit area. A three-section control string saved to the “*DE” variable 
will program the left and right tally blocks and the text colour. An example control s tring: 
 
sv(*DE,2;5;1)TEST 
 
This command saves the text string “5;2;1” to the command variable. The text string is divided into 
three parts by the semi-colons. The first numeric value in the string sets the color of the left tally 
block. The middle numeric value sets the text colour. The last numeric value in the string sets the color 
of the right tally block. 
 
The text block colour codes used in the control string are as follows: 0=white, 1=cyan, 2=green, 
3=magenta.  
 
The tally block colour codes used in the control string are as follows: 0=white, 1=yellow,2=cyan, 
3=green, 4=magenta, 5=red, 6=blue, 7=black. If a tally block colour field is left blank (e.g. 
sv(*DE,,5,) has both tally block fields blank) then that tally block is turned off. 
 
In the example string given above, “sv(*DE,2;5;1)TEST”, the left tally block is green, the text 
“TEST” is red and the right tally block is cyan. 
 
The usual control strings can be embedded in the display text: 
 
sv(*DE,if(iv(0),2,);if(iv(1),5,0);if(iv(2),2,))TEST 
 
In this exa mple, the three control fields are controlled by the first three GPIs. The left tally block is 
green if the first GPI input is active, otherwise the left tally block is off. The text goes red if the second 
GPI is active, otherwise the text is white. The right tally block is green if the third GPI input is active, 
otherwise the right tally block is off.  
 
The Ensemble 5250 interface is available under license, and the option to use the interface must be 
purchased from Image Video. 
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5. Kaleido “Classic” setup 
 
The Kaleido G2 multiviewer in interfaced using the RS422 interface in place of the G2’s remote panel 
port. To set up the G2 RS422 interface, at the Kaleido’s keyboard: 
 
1. Press ‘M’ to open the menu. 
 
2. In “Window Options” set “Text ID” to “On”. 
 
3. In “Input Options” set “Settings” to “Global” and “Tally” to “GPI”. 
 
4. In “System Options” -> “Options” set “UMD Protocol” to “TSL”,  “UMD Port” to ”Disabled” and 

Control Port” to ”RS422”. 
 
5. Use the “LTC RS-422/485” card DB-9 connector to interface the TSI1000. The Receive and 

Transmit lines of the RS422 cable will need to be crossed. 
 

6. Kayak Production Switcher setup 
 
1. Start the DD35 “SidePanel” program. 
 
2. Right-click on SidePanel to bring up the general menu and click “Install”. 
 
3. Click “E-box” and click the “Tally” tab. 
 
4. Check “Red” to set up the program tally. 
 
5. Click a line with “None” in the port column and set the port number to desired physical port. 
 
6. Right-click on each of the Box1, Box2, Box3 columns and set each of them to the unique MPK 

address to be used to address destinations in the Image Video tally system. 
 
7. To tally the preset bus, check “Yellow” and repeat steps 4-6, again giving each column a unique 

MPK address. 
 
8. Right-click on SidePanel to bring up the general menu and click “Config”. 
 
9. Click on “E-box” and on the “Tally In” tab. 
 
10. Set "PP Main" to the inactive state (defaults to active). 
 



 Page 62   

 

Appendix H – PINOUTS 
  
The pinout for the TSI000 DB9 connectors (COM7-COM12) is as follows: 
  
3 - TX+ 
8 - TX-  
4 - TX gnd 
7 - RX+  
2 - RX-  
6 - RX gnd 
1 - Chassis gnd 
9 - Chassis gnd 
  
The pinout for the 4211 DB9 connector is as follows: 
  
3 - RX+ 
8 - RX- 
4 - RX gnd 
7 - TX+ 
2 - TX- 
6 - TX gnd 
1 - Chassis gnd 
9 - Chassis gnd 
 
TSI1000 RJ12 pinouts 
 
Pin Function 
1 Rx-  
2 Gnd 
3 Tx+  
4 Tx-  
5 Not used  
6 Rx+  

  

 
NOTE: RDU1500’s connected to COM3-COM6 use only the center four conductors, and are a pin-to-
pin connection (pin2 to pin2, pin3 to pin 3, etc.) 
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RDU1500 RS232 connection for testing from a PC 
 
RDU1500 

RJ11 
connection 

Standard PC 
RS232 DB-9 

port 
1 No Connection 
2 No Connection 
3 5 
4 3 
5 No Connection 
6 No Connection 
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TSI1000 DB9-to-RJ12 Connections for the Image Video Alarm Tally System 
 
For interconnection of the one of the TSI1000 DB9 connectors to the RJ12 connectors on the alarm 
system, the TSI1000 must receive on the center two pins of the RJ-12 cable coming from the alarm 
system and will transmit on the two outermost pins of the 6-pin connection. DB9-to-RJ12 adapter (IV 
Part# 110-0696-02) is available for this purpose. The wiring of the adaptor is as follows: 
 
DB9 pin 3 TX+ to RJ12 pin 6 (Brown*) 
DB9 pin 8 TX- to RJ12 pin 1  (Orange) 
DB9 pin 7 RX+ to RJ12 pin 3 (Red) 
DB9 pin 2 RX- to RJ12 pin 4 (Green) 
DB9 pin 1 ground to RJ12 pin 2 (Yellow or Black) 
  
*Standard Telco colours. 
 
The numbering of the Alarm detector RJ12 connector pins is the same as that pictured above for the 
TSI1000 RJ12 pins in the section on TSI1000 RJ12 pinouts.
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Model 4211 Parallel Wiring 
 
INPUTS 
 
Pin Function  
 
11 Parallel input 1+ 
 
29 Parallel input 1 - 
 
12 Parallel input 2+ 
 
30 Parallel input 2 - 
 
13 Parallel input 3+ 
 
31 Parallel input 3 - 
 
14 Parallel input 4+ 
 
32 Parallel input 4 - 
 
15 Parallel input 5+ 
 
33 Parallel input 5 - 
 
16 Parallel input 6+ 
 
34 Parallel input 6 - 
 
17 Parallel input 7+ 
 
35 Parallel input 7 - 
 
18 Parallel input 8+ 
 
36 Parallel input 8 - 
 
1 Model 4211 chassis ground 
 
20 Model 4211 circuit ground 
 
19 current limited +5V supply 
 
37 Model 4211 circuit ground 
 
 

OUTPUTS 
 
Pin Function 
 
3 contact closure output 1  
 
21 contact closure output 1  
 
4 contact closure output 2  
 
22 contact closure output 2  
 
5 contact closure output 3  
 
23 contact closure output 3  
 
6 contact closure output 4  
 
24 contact closure output 4  
 
7 contact closure output 5  
 
25 contact closure output 5  
 
8 contact closure output 6  
 
26 contact closure output 6  
 
9 contact closure output 7  
 
27 contact closure output 7  
 
10 contact closure output 8  
 
28 contact closure output 8  
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